MacSPIRS™
User’s Manual

SilverPlatter®
Version 4.0
Draft: For Beta Release March 1999
# Table of Contents

Preface .......................... vii  
Using this Manual .......................... vii  
Some Conventions used in this Manual .......................... vii  

Chapter 1 Introduction .......................... 1-1  
Before You Begin .......................... 1-1  
What is in this Manual? .......................... 1-1  
Contacting SilverPlatter .......................... 1-3  

Chapter 2 Installing MacSPIRS .......................... 2-1  
If You Have an Earlier Version of MacSPIRS .......................... 2-1  
Checking Hardware and Software Requirements .......................... 2-2  
Installing MacSPIRS .......................... 2-2  
Running the Installer .......................... 2-2  
   From SilverPlatter’s FTP Site .......................... 2-2  
   From the Software Resource CD .......................... 2-3  
Selecting a Type of Installation .......................... 2-3  
Identifying the New or Existing Application .......................... 2-5  
Selecting an Application Type .......................... 2-6  
Selecting Software Options .......................... 2-8  
   Printable records .......................... 2-8  
   Allow user to exchange databases .......................... 2-8  
   Automatic Restart .......................... 2-9  
   Update Magnetic Files .......................... 2-9  
   Allow Simultaneous Users .......................... 2-9  
   Allow SDIs and Alerts .......................... 2-9  
Specifying ERL Passwords .......................... 2-9  
   Concealing ERL Login Information .......................... 2-10  
   When the Installation is Complete .......................... 2-11  
Network Installation Instructions .......................... 2-11  
   Installing MacSPIRS on a Novell File Server .......................... 2-11  
   Installing MacSPIRS on an AppleTalk Network .......................... 2-12  
Configuring MacSPIRS .......................... 2-12  
   Turning Off Immediate Record Display .......................... 2-12  
   Setting Default Fields .......................... 2-13  
   Accessing Databases in Network Directories .......................... 2-13  
   Standardizing MacSPIRS File Names .......................... 2-14  
   Changing MacSPIRS Memory Requirements .......................... 2-14
Making MacSPIRS the Startup Application ........................................... 2-15
Setting Interface Preferences ......................................................... 2-16
Setting up SilverLinker ............................................................... 2-17
Setting up SDIs and Alerts ............................................................ 2-17
  Links to WebSPIRS for SDIs ....................................................... 2-17
  Configuring MacSPIRS to Allow SDIs and Alerts ......................... 2-18
  SDI Menu Items ........................................................................ 2-20
  Creating an SDI and Subscribing to an Alert ................................. 2-20
Providing Library Holdings Information .......................................... 2-20
  About the Holdings Conversion Utility (HCU) ............................... 2-20
  About SPLHA ........................................................................... 2-21
  Making Holdings Information Available ...................................... 2-21
  Disabling Holdings for Specific Databases .................................. 2-21
  Default Holdings Messages ....................................................... 2-22
Chapter 3 MacSPIRS Basics ............................................................. 3-1
  Starting MacSPIRS ...................................................................... 3-1
  Selecting a Database .................................................................... 3-2
  If only one database is available ................................................ 3-2
  If multiple databases are available ............................................. 3-2
  Exchanging Databases ................................................................ 3-4
    Exchanging Databases in a Single-Drive System ....................... 3-4
    Exchanging Databases in a Multiple-Drive System .................... 3-4
MacSPIRS at a Glance ..................................................................... 3-6
  Finding and Showing Records .................................................... 3-6
  Using the Index ......................................................................... 3-8
  Using the Thesaurus ................................................................... 3-9
  Getting Online Help .................................................................... 3-10
  Context Sensitive Help ................................................................ 3-10
  Menu Help ................................................................................ 3-10
  Database and Field Information ................................................. 3-12
  Ending a Search Session ............................................................. 3-13
  Quitting MacSPIRS .................................................................... 3-13
  Restarting MacSPIRS .................................................................. 3-13
Chapter 4 Searching with MacSPIRS ............................................... 4-1
  Using the Find Records Dialog Box ............................................. 4-2
  Performing a Simple Search ........................................................ 4-2
  Valid Search Statements ............................................................. 4-3
  Using Truncation and Wildcards .................................................. 4-4
  Searching for Hyphenated Phrases .............................................. 4-4
    Including Hyphens for a Focused Search ................................. 4-5
Omitting Hyphens for a Broad Search .......................... 4-5
Using Parentheses ............................................. 4-5
Combining Terms with Operators .............................. 4-6
Searching in Specific Fields ................................. 4-9
Searching in Limit Fields ..................................... 4-10
Using the Suggest Feature .................................... 4-11
Using the Index .................................................. 4-12
Changing Indexes ................................................. 4-14
Using the Thesaurus ............................................. 4-15
  Looking Up a Thesaurus Term ............................... 4-15
  Getting Details about a Selected Thesaurus Term .... 4-16
  Displaying Trees ............................................. 4-17
  Searching for Thesaurus Terms ............................. 4-18
    If You Have a List of Searches ......................... 4-19
    Selecting Subheadings ................................... 4-20
Using the Search History ..................................... 4-21
  Reusing Search Requests .................................. 4-22
  Clearing Search Requests ................................. 4-23
  Saving a Search History ................................. 4-23
  Running a Saved Search History ......................... 4-24
Using Current Awareness Searches: SDIs and Alerts ...... 4-26
  SDI Menu Items ............................................. 4-27
  Creating an SDI from MacSPIRS ............................ 4-27
  Editing SDI Settings ....................................... 4-28
  Subscribing to an Alert .................................... 4-28
Searching Multiple Databases ................................ 4-29
Narrowing and Broadening Your Search ..................... 4-29

Chapter 5 Using Retrieved Records .......................... 5-1
  Showing Records ............................................. 5-1
    Changing Show Options ................................ 5-1
    Showing a Subset of Records ............................ 5-3
    Showing a Subset of Fields ............................. 5-4
    Sorting Records .......................................... 5-5
  Searching from Retrieved Records ....................... 5-6
  Displaying Hotlinked Records .............................. 5-6
  SilverLinker Support ...................................... 5-8
  Displaying Local Library Holdings Information ........ 5-8
  Selecting Records .......................................... 5-9
    Using the Retrieved Records Window ................ 5-9
    Using the Show Records dialog box ................. 5-10
    Deselecting records ................................. 5-11
Printing Records ............................................... 5-12
Printing a Subset of Fields .................................. 5-13
Changing Print Options ...................................... 5-14
Saving Records ................................................ 5-15
Saving a Subset of Fields .................................... 5-16
Changing Save Options ...................................... 5-18

Chapter 6 MacSPIRS Commands ............................. 6-1
Preface

This manual explains how to install, configure, and use MacSPIRS v4.0.

Using this Manual

This manual is available in PDF format so you can view it in Adobe Acrobat Reader. You can print the document, or use it online. If you use it online you can click on a Table of Contents entry, or a cross-reference, to move to the relevant text.

Some Conventions used in this Manual

These are the conventions used throughout this manual:

<table>
<thead>
<tr>
<th>Example</th>
<th>Describes</th>
</tr>
</thead>
<tbody>
<tr>
<td>/sproot/bin</td>
<td>This bold type indicates a filename, or a URL.</td>
</tr>
<tr>
<td>pkgadd</td>
<td>This typeface indicates text as you would type it, or an example of how it appears on the screen.</td>
</tr>
<tr>
<td>filename</td>
<td>This bold type indicates a placeholder, when included in something you type. You substitute the text appropriate to your system.</td>
</tr>
<tr>
<td>filename</td>
<td>This italic type indicates a placeholder, when described in the text.</td>
</tr>
<tr>
<td>root</td>
<td>This italic type indicates an account name.</td>
</tr>
</tbody>
</table>

(Sheet 1 of 2)
<table>
<thead>
<tr>
<th>Example</th>
<th>Describes</th>
</tr>
</thead>
<tbody>
<tr>
<td>File</td>
<td>This bold type indicates a menu, menu option, or the name of a button on the screen. It is also used for command names.</td>
</tr>
<tr>
<td>[Enter]</td>
<td>This bold type inside [ and ] indicates a key on your keyboard. Note: if the instructions say &quot;Enter...&quot; this means type in the text as instructed, (substituting your text for any placeholders) and press the [Enter] key.</td>
</tr>
</tbody>
</table>
Chapter 1

Introduction

SilverPlatter databases are organized collections of records. Each record represents an article, book, bibliographic citation, etc. Records are divided into categories of information known as “fields,” such as title, author, etc.

MacSPIRS, the SilverPlatter Information Retrieval System for the Macintosh, lets you search SilverPlatter databases and display, print, or save the retrieved records. You can also save your search strategy to use again in later sessions.

Before You Begin

Before you begin working with MacSPIRS, you should be familiar with general Macintosh techniques, such as using the mouse and Option button, and resizing windows. This guide uses standard Macintosh terminology (“mouse,” “window,” etc.) and only discusses Macintosh utilities when they interact with MacSPIRS commands. If you are not familiar with the Apple Macintosh, we recommend that you read through its documentation before using MacSPIRS.

What is in this Manual?

Listed below are brief descriptions of the contents of this manual

<table>
<thead>
<tr>
<th>Read...</th>
<th>If you are...</th>
<th>It will tell you...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 2</td>
<td>Responsible for installing MacSPIRS</td>
<td>How to get the software, and install and configure it.</td>
</tr>
<tr>
<td>Chapter 3</td>
<td>A MacSPIRS user</td>
<td>How to use the different MacSPIRS screens</td>
</tr>
</tbody>
</table>

(Sheet 1 of 2)
<table>
<thead>
<tr>
<th>Read...</th>
<th>If you are...</th>
<th>It will tell you...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 4</td>
<td>A MacSPIRS user</td>
<td>How to search using MacSPIRS</td>
</tr>
<tr>
<td>Chapter 5</td>
<td>A MacSPIRS user</td>
<td>How to use the records you find: marking, sorting, printing, and downloading records, and changing various options.</td>
</tr>
<tr>
<td>Chapter 6</td>
<td>A MacSPIRS user</td>
<td>An alphabetical list of menu items and buttons.</td>
</tr>
</tbody>
</table>

(Sheet 2 of 2)
Contacting SilverPlatter

To learn more about SilverPlatter software, or if you have any queries about installing and running the ERL Server software, please do one of the following:

- Email our Technical Support staff:
  support@silverplatter.com

- Call your SilverPlatter distributor, or one of the following SilverPlatter Technical Support teams:

  - **For the Americas, Japan, Australia, and the Pacific:**
    Boston Office:
    Tel: 1-781-769-2599
    1-800-343-0064 (US/Canada)
    Fax: 1-781-769-8763

  - **For Europe, Africa, Middle East, and South Asia:**
    London Office:
    Tel: +44 (0)181-585-6400
    0800-262-096 (UK)
    Fax: +44 (0)181-585-6640

    Amsterdam Office:
    Tel: +31 (0) 20 6259650
    Fax: +31 (0) 20 6237408

    Berlin Office:
    Tel: +49 30-85 77 99-0
    Fax: +49 30-85 77 99-99

  - **For Asia:**
    Hong Kong Office
    Tel: 852 2529 0356
    Fax: 852 2804 2746

- Access the SilverPlatter website:
  www.silverplatter.com
Chapter 2

Installing MacSPIRS

This chapter provides details on installing MacSPIRS. It is divided into the following sections.

- If you have an earlier version of MacSPIRS
- Hardware and Software Requirements
- Installing MacSPIRS
- Network Installation Instructions
- Configuring MacSPIRS
- Making MacSPIRS Your Startup Application
- Setting Interface Preferences

If You Have an Earlier Version of MacSPIRS

If you have MacSPIRS 2.2 installed, MacSPIRS ignores that earlier version. You cannot re-use the configuration files from the earlier version, and we recommend that you delete the old Overrides folder from the System folder.

If you have MacSPIRS 2.4, and the Overrides folder is in the Preferences folder in the System folder, we recommend you make a backup of your `macspirs.ini` file. MacSPIRS asks if you want to retain your existing `macspirs.ini` during installation. We recommend you say “no” so that you will install a new file, with all the additional 4.0 features. If you make a backup of the old file, you can use that to restore any settings you have made in the previous version that are still relevant in 4.0.
Checking Hardware and Software Requirements

Before you start to install the software you must check the hardware requirements for your platform.

For the very latest information about hardware requirements, please see the SilverPlatter web site at:

http://www.silverplatter.com/erl/erclientreq.htm

Note: MacSPIRS requires the System 7 operating system, or later.

Installing MacSPIRS

Below are the steps for installing MacSPIRS. Help is available on each of the installation screens.

Note: During the installation, some anti-virus programs like Vaccine, SAM, and GateKeeper may notify you that code resources are being modified. If this occurs, you may need to turn off the anti-virus program to complete the MacSPIRS installation.

Running the Installer

The instructions for running the MacSPIRS Installer depend on whether you are running it from SilverPlatter’s FTP site, or the Software Resource CD. Please call our Technical Support staff if you cannot access the software using these methods.

From SilverPlatter’s FTP Site

The SilverPlatter FTP site contains all of the current ERL and SPIRS software, as well as beta versions of future releases. If you have FTP capabilities, you can download MacSPIRS 4.0.

Note: MacSPIRS is distributed via FTP in BinHex format. The archive file (macspirs.sea.hqx) must be un-BinHexed before you can extract the MacSPIRS files. Certain Macintosh FTP utilities, like Fetch, will do this automatically during the download process. Refer to your FTP software documentation for more information.

1. Using Fetch (or a comparable FTP utility), access SilverPlatter’s site at ftp.silverplatter.com.
2. If necessary, login as anonymous and provide your email address as
your password.
3. Change directories to software/erl-clients/mac/.
4. Download and un-BinHex macspirs.sea.hqx.
5. Once downloading is complete, double-click on MacSPIRS.sea.
6. At the introductory screen, click Continue.
7. Select an existing folder or name a new folder in which to place the MacSPIRS files.
8. Click Save.
9. A message appears when the MacSPIRS files are extracted. Click Quit to exit the archive.
10. Double-click on the SP Installer 4.0 icon to begin the installation.

From the Software Resource CD
SilverPlatter regularly distributes its current ERL and SPIRS software on the “SilverPlatter Software Resource CD”. If you have a copy of the Resource CD, follow the instructions below.
1. Open the MacSPIRS 4.0 folder on the Resource CD.
2. Double-click on the SP Installer 4.0 icon to begin the installation.

Selecting a Type of Installation
There are three types of MacSPIRS installations, as described below.

To select a type of installation:
1. Select the installation you want to perform.

   - Click **Full Installation** to install a new MacSPIRS application or to replace a previous version of MacSPIRS.
   - Click **Reconfigure Installed Application** to change the software options of an existing MacSPIRS application.
   - If available, click **Preconfigure Defaults** to set ERL (Electronic Reference Library) login options. This modifies the Installer for future installations.

   **Note:** If you select this installation option, some of the following steps do not apply. See the *ERL Administrator's Manual* available at the SilverPlatter ftp site, for example at:

2. Click **OK**.

3. If you selected the **Full Installation** option, MacSPIRS displays the
User License dialog box.

![Subscription & License Agreement]

FIGURE 2-2 The User License dialog box

- If necessary, click the **Version** pop-up menu to change between other language versions of the License Agreement.
- Click **Print Agreement** to print a copy of the User License Agreement.
- Click **Accept** to accept the license agreement and continue the installation.
- Click **Decline** to cancel the installation.

**Identifying the New or Existing Application**

If you chose the **Full Installation** or **Reconfigure Installed Application** option, you are asked to name the new application or locate the application you want to modify.

1. Identify the MacSPIRS application:
   - If you selected **Full Installation**, identify the drive and folder in which to create the new MacSPIRS application, and provide a name for the new application.
   - If you selected **Reconfigure Installed Application**, identify the drive and folder in which the MacSPIRS application to modify exists, and indicate the name of the application.

2. Click **Save**.
Selecting an Application Type

The next step in the installation process involves selecting the type of application and installation code you want to install through the Application Type dialog box. If you are installing or modifying a MacSPIRS ERL client, you can also specify the servers you want to access.

![Application Type dialog box]

**FIGURE 2-3 The Application Type dialog box**

1. If you are performing a full installation or reconfiguring an existing application, select the application type:
   - Click **Standalone Only** for an application that can access databases on local drives and networks only. Select **Standalone Only** if your Macintosh will not be connected to an ERL server.
   - Click **ERL Client Only** if your Macintosh will be connected to an ERL server but not to a local network or CD-ROM drive.
   - Click **Both (Client & standalone)** if your Macintosh will be connected to an ERL server and one or more local networks or CD-ROM drives.

2. Select the type of code you want to install:
   - Click **FAT Binary** for a version of MacSPIRS that will run as a native application on either a 68K or PowerPC machine. This version requires more disk space than the other versions.
   - Click **68K** for a version of MacSPIRS that will run as a native application on a 68K machine, or under emulation on a
PowerPC machine. (Note: Performance may be slower on a PowerPC.)

- Click **Native PPC Only** for the PowerPC version of MacSPIRS.

**Note:** These options are only available if you are performing a full installation. Refer to “Selecting a Type of Installation” on page 2–3 for more information.

**Note:** If you try to run the Native PPC version on a 68K machine by mistake, the installation will succeed, but you will see an error message when you try to run MacSPIRS.

3. If you chose the **ERL Client Only** or **Both (Client & standalone)** application type in step 1, you can add, edit, or delete ERL server addresses.

**Note:** The ERL server addresses you enter are stored in the ERL Configuration (erlcont.cfg) file in the MacSPIRS Overrides folder. If you want to use the server addresses from an existing erlcont.cfg file, click **Switch CFG file** and select the appropriate file.

To add a server address:

1. Click **Add Server**.
2. Enter the server’s IP address or host name in the Add Server dialog box.
3. Click **OK**.

To edit a server address:

1. If necessary, click **Next** to display the server address you want to edit.
2. Click **Edit**.
3. Modify the server’s IP address or host name in the Edit Server dialog box.
4. Click **OK** in the Edit Server dialog box.

To delete a server address:

1. If necessary, click **Next** to display the server address you want to delete.
2. Click **Delete Server**.
3. Click **OK** in the Delete Server dialog box.
4. Click **OK** in the Application Type dialog box to continue the
installation.

**Selecting Software Options**

The MacSPIRS software options, explained below, determine how MacSPIRS will operate. These options are available if you are installing MacSPIRS for the first time or reconfiguring an existing application.

To select software options:

1. In the Software Options dialog box, click on the option settings you prefer, and type in data where required.

![Software Options dialog box](image)

**FIGURE 2-4 The Software Options dialog box**

2. Click **OK**.

**Printable records**

Specify a maximum number of records that users can print, or accept the default that **All** records can be printed. If users try to exceed the limit you set, they will be given the option of printing the limited number of records or none at all.

**Allow user to exchange databases**

Indicate whether users can switch databases without leaving MacSPIRS. If you click **Yes**, the **Exchange Databases** command in the **File** menu is available to users; if you click **No**, the command is unavailable.
Automatic Restart

You can set up MacSPIRS so that it automatically restarts after a given period of inactivity. Each time MacSPIRS restarts, the Search History window is cleared and all options and window characteristics are reset to their defaults.

- If you want MacSPIRS to automatically restart after a period of inactivity, click **Timeout (minutes)** and type the number of minutes MacSPIRS should be inactive before restarting.
- If you do not want MacSPIRS to automatically restart after a period of inactivity, click **None**.

Update Magnetic Files

If a MacSPIRS application has already been installed on your Macintosh and you are reconfiguring it or installing a new one, you have the option of not updating the MacSPIRS magnetic support files. These files are unaffected by changes to the software options.

- Click **Yes** if you want to reinstall the MacSPIRS magnetic support files.
- Click **No** if you do not want to reinstall the support files.

Allow Simultaneous Users

If you are installing MacSPIRS on a network and want to allow simultaneous users, click **Yes**; otherwise, click **No** to limit MacSPIRS to one user at a time.

Allow SDIs and Alerts

If you want to let your users use the SDI and Alerts feature, click **Yes**; otherwise, click **No**.

If you choose Yes, you see an additional dialog box, this is described at “Setting up SDIs and Alerts” on page 2–17.

Specifying ERL Passwords

If you are installing MacSPIRS as an ERL Client Only or Both (Client & standalone) application, you can preconfigure usernames and passwords for automatic login to the ERL servers you specified during
installation. (For more information on specifying server addresses, refer to “Selecting an Application Type” on page 2–6.)

![ERL Auto Login Setup dialog box](image)

**FIGURE 2-5 The ERL Auto Login Setup dialog box**

To specify ERL passwords:

1. Enter the following information for each server you want to access:
   - **Server ID** for each IP address or host name listed in the Application Type dialog box. Precede each ID with `$S$`, such as `$S$SERVER1_ID` or `$S$server2`.
   - **User ID** for each Server ID.
   - **Password** for each Server ID.

   **Note:** You can omit the Server IDs and enter a single User ID and Password instead. If you do, MacSPIRS will use that User ID and Password to log on to all the servers you specified in the Application Type dialog box.

   If you want to prompt users for the username and password, leave the User ID and Password fields blank. If you want to prompt users for the password only, enter a question mark (?) in the Password field.

2. Click **OK**.

**Concealing ERL Login Information**

After configuring the Installer and verifying your server connections, you can hide the ERL login information. Doing so allows you to
distribute a fully configured application without revealing server information.

To conceal ERL login information:
1. Complete the installation and run the new MacSPIRS application.
2. If you are satisfied with the server connections, rerun the Installer and select **Preconfigure Defaults**.
3. Check the **Conceal this Dialog** option to hide the ERL Auto Login Setup dialog box.
4. Click **OK**.

### When the Installation is Complete

When the installation is complete, whichever of the installation types you have performed, you will see a message confirming successful installation; click the **OK** button that accompanies this message to exit the MacSPIRS Installation program.

### Network Installation Instructions

Using MacSPIRS in a network environment allows you to search more than one database at once, and saves you time in that you do not need to physically change disks each time you want to search a different database.

### Installing MacSPIRS on a Novell File Server

You can install MacSPIRS on a Novell file server to make the databases mounted on the server available to every Macintosh on the Novell network. Each Macintosh will be able to run MacSPIRS, whether or not MacSPIRS has been installed on that computer.

To install MacSPIRS on a Novell server:
1. Install MacSPIRS on a Macintosh. Refer to “Installing MacSPIRS” on page 2–2 for information.
2. When the installation is complete, move the MacSPIRS Overrides folder from the Preferences folder in the System folder of your Macintosh to the folder in which you installed MacSPIRS.
3. Move the entire MacSPIRS folder to the desired volume on the Novell server. The server must be running NetWare for Macintosh.
4. From a Novell workstation, flag all the MacSPIRS files on the server as **shareable, read only**.
If ever you need to update or reconfigure MacSPIRS, you must do so from a Macintosh.

**Installing MacSPIRS on an AppleTalk Network**

You can install MacSPIRS on an AppleTalk network so that each Macintosh in the network can access the databases loaded on the local drives of every other Macintosh in the network. This installation allows a user to run MacSPIRS from a remote Macintosh.

To install MacSPIRS on an AppleTalk network:
1. Install MacSPIRS on a Macintosh. Refer to “Installing MacSPIRS” on page 2–2 for information.
2. Verify that **File Sharing** and **Program Linking** are on.
3. At each Macintosh, Share the CD-ROMs to be made available to the network.
4. At each Macintosh, Duplicate the MacSPIRS application so that each user runs a different copy of MacSPIRS but shares common resource files.

**Configuring MacSPIRS**

Once MacSPIRS is installed, you can change certain system options, such as immediate record display, default fields, subdirectory access, and capitalization of file names through the `macspirs.ini` file. This file is located in the MacSPIRS Overrides folder within the Preferences folder in the System folder. You can also change the default memory requirements for running MacSPIRS.

**Turning Off Immediate Record Display**

For faster searching, you can prevent MacSPIRS from showing records automatically after each search. To do so, edit the `InstantRecords` setting in the 'Show' section of the `.ini` file as shown below:

```
[Show]
InstantRecords=0
```

After changing the default, you must click **Show Records Found** in the Find Records dialog box or select **Show All Records** from the **Show** menu to view retrieved records. Refer to “Showing Records” on page 5–1 for more information.
Setting Default Fields

MacSPIRS allows you to set default fields for showing, printing, and saving records. You can apply these default fields to all databases or to a specific database family by editing the `UsrFields` setting in the `.ini` file. For example, to specify TI (Title) and AU (Author) as the default display fields for all databases, edit the `UsrFields` setting in the Show section as shown below:

```
[Show]
UsrFields=TI, AU
```

MacSPIRS will show these default fields when displaying records from any database.

To set different default fields for a particular database family, add the two-letter database family code to the `UsrFields` setting. For example, to specify AB (Abstract) as a default field, but only for records from the MEDLINE (ML) database family, type the following:

```
[Show]
UsrFields=TI, AU
UsrFields-ML=TI, AU, AB
```

TI and AU will be the general default fields for all databases. Records from any MEDLINE database will display the TI, AU, and AB default fields.

**Note:** `macspirs.ini` provides a partial list of database family codes; if the code you need is not included in this list, contact SilverPlatter.

Accessing Databases in Network Directories

If your Macintosh is attached to a network, you can configure MacSPIRS to access databases stored on network directories. To do this, add the directory name to the appropriate `DIRMAP` (1, 2, 3, etc.) setting in the `.ini` file. (The number of `DIRMAP` settings will vary according to your system’s configuration.)

For example, to have MacSPIRS look for a database in “splib,” a subdirectory of “hd330” on `DIRMAP1`, edit the setting as shown below. Make sure there are no spaces in the hard drive name.

```
DIRMAP1=hd330:splib
```

When you start MacSPIRS again, it will look for databases in the “splib” subdirectory of “hd330”, as well as any local CD-ROM drives and accessible ERL servers.
If a network directory has multiple subdirectories, use the wildcard symbol (*) to automatically locate and map to all databases found in the subdirectories. For example, to locate databases in the subdirectories of “1GBDrive:\spdb”, edit the setting as shown below:

```
DIRMAP2=1GBDrive:spdb:*
```

MacSPIRS will look for databases in all subdirectories of “1GBDrive:\spdb”, as well as any local CD-ROM drives and accessible ERL servers.

**Note:** Generally, network subdirectories will contain a single database. With the exceptions of MEDLINE Express and EMBASE Express, subdirectory names do not have to match the database’s volume ID. Consult your system administrator for more information on network subdirectories.

**Standardizing MacSPIRS File Names**

If you are running MacSPIRS on a case-sensitive server, you can change all file names to upper or lower case by editing the MAC section of the `macspirs.ini` file.

To standardize the case of all MacSPIRS file names, go to the MAC section in the `.ini` file and change the `ForceCase` setting to 1 (for upper case) or 2 (for lower case) as shown below:

```
[MAC]
ForceCase=1
```

or

```
[MAC]
ForceCase=2
```

**Changing MacSPIRS Memory Requirements**

By default, the minimum and preferred memory requirements for MacSPIRS are 2 MB and 4 MB, respectively.

These settings, listed in the MacSPIRS Info dialog box, indicate the amount of system memory currently needed to run MacSPIRS.
Making MacSPIRS the Startup Application

If necessary, you can increase the amount of preferred memory to as much as 12 MB or reduce it to as little as 2.5 MB.

Note: Reducing the amount of preferred memory is recommended if you are running MacSPIRS on a machine with 4 MB RAM and experience system crashes when selecting databases.

Making MacSPIRS the Startup Application

To make MacSPIRS the startup application, use the Set Startup command in the Special menu of your Macintosh. This command allows you to run an application automatically when you start your Macintosh.

To dedicate your Macintosh to running MacSPIRS:

1. Arrange your Desktop so that you can see the MacSPIRS icon.
2. Select MacSPIRS by clicking once on the MacSPIRS icon to highlight it.
3. Select Set Startup from the Special menu.
4. Click OK.
5. Select Restart from the Special menu. Your Macintosh starts MacSPIRS automatically.

Setting Interface Preferences

MacSPIRS allows you to set certain interface preferences, including the color of various display elements, font and font size, and window positions.

To set interface preferences:
1. If necessary, start MacSPIRS.
2. Select Preferences from the Edit menu. The Preferences dialog box opens.

![FIGURE 2-7 The Preferences dialog box](image)

3. Change the color and font settings as needed.
4. If you want the main MacSPIRS windows (such as the Retrieved Records window) to always open in their current positions, check the Save window settings box.
5. Click Save.

Your settings are saved in the MacSPIRS Preferences file in the Preferences folder.

To change back to the original default settings:
1. Select **Preferences** from the **Edit** menu.
2. When the Preferences dialog box opens, click **Revert to Defaults**.
3. Click **Save**. MacSPIRS returns all color, font, and window options to their default settings.

**Setting up SilverLinker**

MacSPIRS 4.0 includes support for the SilverLinker database, which provides links from bibliographic records to the full text of articles in electronic journals to which your library subscribes.

The SilverLinker database contains URL links from articles. These links are displayed dynamically within SilverLinker-enabled bibliographic databases. The links appear as hotlinks in a separate field with the short name **FTXT** and link directly to the website where the full text article is located.

The **FTXT** field must be set to display, so that users will see the SilverLinker links. See “Setting Default Fields” on page 2–13 for details of how to set default fields for displaying records.

SilverLinker full-text links are displayed only when the SilverLinker database, and your SilverPlatter bibliographic databases, are installed on ERL dbserver 4.0. They are not available if MacSPIRS is installed locally. In addition, your institution must have subscriptions to electronic journals at the web site or sites that host the full text.

For more information about SilverLinker see the *ERL Administrator’s Manual* available at the SilverPlatter ftp site, for example at:


**Setting up SDIs and Alerts**

**Links to WebSPIRS for SDIs**

In libraries that have the WebSPIRS 4.0 or later (4+) gateway installed, you can link MacSPIRS 4.0 to WebSPIRS so that authorized users can access the SDI (Selective Dissemination of Information) current awareness search feature.
The SDI feature lets users save and identify searches to be rerun automatically. The user specifies the interval at which they want the search to be rerun along with the email address to which search results are to be returned.

With WebSPIRS 4.1, the Alert feature is also available: authorized users can subscribe to a selection of searches prepared by the administrator or librarian. These searches are run periodically, and the results emailed to the user.

You must have the following components to take advantage of these features:

- An account on a WebSPIRS 4+ server and an internet or intranet connection and its URL to access WebSPIRS 4+.
- A browser: Netscape 3.01 or Internet Explorer 4, or later.
- Access to the databases required for the SDI.
- Two logins assigned on the ERI Server, for when a user creates or edits an SDI. This is because the ERL Server treats the contact between MacSPIRS and WebSPIRS, which takes place through the Server, as two simultaneous Server users: one a MacSPIRS user, and one a WebSPIRS user. In some circumstances, these two users will share the same username. For this reason, you should set the Server’s limit on the number of simultaneous logins for a single username to two or more.

Note: The databases selected for a MacSPIRS search must be available on the WebSPIRS server hosting the SDIs.

For information about configuring WebSPIRS for SDIs and Alerts, see the WebSPIRS Implementor’s Guide, available at the SilverPlatter website at [http://webspirs.silverplatter.com/ws40docs/](http://webspirs.silverplatter.com/ws40docs/)

**Configuring MacSPIRS to Allow SDIs and Alerts**

You give or restrict access to the SDI feature using the MacSPIRS 4.0 software option: Allow SDIs. You can do this if you are installing MacSPIRS for the first time or reconfiguring an existing application.

To setup the SDI feature:

1. Use the Installer to access the Software Options dialog box. (See “Selecting Software Options” on page 2–8.)
2. Check Allow SDIs to display the SDI Setup dialog box.
3. Enter the URL for WebSPIRS.
4. Enter a username and password, if you want to.

   **Note:** MacSPIRS creates a reference to the browser used to access the SDI feature the first time a user uses the feature. If you replace a user’s browser, MacSPIRS will still try to open the previous browser, and will fail. To avoid this, you must delete the user’s MacSPIRS preferences file. MacSPIRS will create a new file when the user opens MacSPIRS, and will create the reference to the new browser when the user first uses the SDI feature. You may want to make a backup of the preferences file, and edit the new file to retain any earlier preferences.

5. Click **OK** to close the SDI Setup dialog box.
**SDI Menu Items**

MacSPIRS 4.0 contains new **File** menu items that function with the SDI feature. The following menu items appear *only* after MacSPIRS has been configured to enable the SDI feature.

<table>
<thead>
<tr>
<th>Use this File Menu Item</th>
<th>To do this</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Save As SDI</strong></td>
<td>Set up an SDI. After conducting a search and choosing this menu item, MacSPIRS 4 links automatically to WebSPIRS and displays the Create SDI screen.</td>
</tr>
<tr>
<td><strong>Show SDI Account</strong></td>
<td>Edit or administer existing SDIs by linking to WebSPIRS to view an account users set up previously.</td>
</tr>
<tr>
<td><strong>Alert Services...</strong></td>
<td>View and subscribe to alerts by linking to WebSPIRS 4.1 or later.</td>
</tr>
<tr>
<td><strong>SDI Set up...</strong></td>
<td>View and edit the settings to access WebSPIRS.</td>
</tr>
</tbody>
</table>

**Creating an SDI and Subscribing to an Alert**

For instructions on how your users create SDIs, and subscribe to Alerts, see “Creating an SDI from MacSPIRS” on page 4–27 and “Subscribing to an Alert” on page 4–32.

**Providing Library Holdings Information**

The Holdings Conversion Utility (HCU) lets you display local holdings information about SilverPlatter bibliographic databases.

**About the Holdings Conversion Utility (HCU)**

HCU converts a library’s serials holdings file (in ASCII or MARC format) into a SilverPlatter formatted file which, when installed on a server or stand-alone system, can be used to display local holdings information along with SilverPlatter bibliographic records. HCU-generated files support the display of holdings information within any ISSN-based SilverPlatter database. HCU can be installed on either a Windows 32-bit platform or a UNIX platform.
MacSPIRS 4.0 supports library holdings for all databases supported by the Holdings Conversion Utility (HCU).

If users have a browser running on a MacSPIRS 4.0 workstation, MacSPIRS also supports holdings messages with embedded URLs. (Earlier versions of MacSPIRS do not support URLs embedded in holdings messages.)

For details of how to create library holdings information, see the Holdings documentation available at SilverPlatter’s ftp site, for example at: ftp://ftp.silverplatter.com/software/hcu/solaris/.

About SPLHA

MacSPIRS 4.0 will continue to support files generated by the earlier utility: SilverPlatter Library Holdings Administration (SPLHA). However, MacSPIRS 4.0 does not support both formats simultaneously. Your holdings must be in either the SPLHA format or converted to the new holdings format.

Making Holdings Information Available

To make holdings information available:

- If you are using files generated by the Holdings Conversion Utility (splha.lhd, splha.lhi, and splha.lhm), put these three files into the MacSPIRS Overrides folder.
- If you are using files generated by the earlier SPLHA utility, put the two files (.lhm and .lhd) into the MacSPIRS Overrides folder.

If these files are installed, MacSPIRS shows additional fields in retrieved records. These fields display information about the local holdings, if that information is available.

The additional fields are *LHM and *LHC. These fields must be set to display so that users will see the holdings messages. See “Setting Default Fields” on page 2–13 for details of how to set default fields for showing records.

See “Default Holdings Messages” on page 2–22 for details of how to configure MacSPIRS to display default messages if holdings information is not available.

Disabling Holdings for Specific Databases

MacSPIRS 4.0 lets you exclude holdings information for specific databases. If you do this, holdings messages do not appear in records from the databases you specify. This mechanism applies only to locally mounted databases. Records from databases accessed using an ERL
server will still show holdings messages, unless holdings from these databases are disabled at the ERL server.

To disable a database from displaying holdings messages:

1. Open \texttt{macspirs.ini} in a text editor.
2. Go to the first section, which starts with `[ ]`.
3. Find tag `!42`. Delete the semi-colon (`;`) at the beginning of the tag. (This makes the tag active.)
4. Enter a comma-delimited list of the database families for which you do not want holdings messages to display.
   
The default is for holdings messages to display for all SilverPlatter databases. If you explicitly list in this file some subset of your databases for which holdings message display is disabled, holdings messages will display only for those database families you have not included in the list.

For example:

If your library subscribes to the following databases:

- Medline Advanced (M Edwards)
- PsycInfo (PY)
- Sociofile (SO)
- Cinahl (NU)

you might want holdings messages to display only for Medline Advanced and PsycInfo. So you add the following to \texttt{macspirs.ini}:

\begin{verbatim}
!42=SO,NU
\end{verbatim}

\textbf{Note:} You must enter the database family names, and you must separate each with a comma.

An example line appears in \texttt{macspirs.ini}, commented out by an initial semicolon.

\section*{Default Holdings Messages}

You can enable the display of default holdings messages for situations when MacSPIRS cannot identify a message to display from your HCU-generated holdings file. The most common occurrence of this would be
for journals that your library does not subscribe to, although other circumstances might also cause this.

**Note:** This mechanism applies only to locally mounted databases. Records from databases accessed using an ERL server will not show these messages. A similar mechanism is available for configuring an ERL server to provide default messages. See the *ERL Administrator’s Manual* available at the SilverPlatter ftp site, for example at: ftp://ftp.silverplatter.com/software/erl-server/solaris/ for details.

The `macspirs.ini` file contains a list of numeric tags and text messages associated with various conditions that result in no holdings information being available for display:

```plaintext
;!50=Holdings files missing or incomplete
;!51=Holdings files have no compatible keys
;!52=Holdings for this database family disabled
;!53=No holdings key field in record
;!54=No holdings key found in field
;!55=The holdings key in this record is invalid
;!56=Holdings index file corrupt - rebuild
;!57=No holdings information for this record
```

You specify which of these messages you want to display, and you can change the text displayed.

To change the default holdings messages:

1. For any condition for which you would like a default message to display, open the `macspirs.ini` file in your text editor.

2. Delete the semi-colon (;) at the beginning of the tag which corresponds to the condition for which you would like a default message to display.

   You can leave the text as it is, or edit the text to display any wording you wish. If messages span multiple lines, you must type \n at the end of each separate line of text at the point where you wish the line-break. If you press [Enter] at the end of a line, the message will be truncated at that point.

For example:

   If you want to display a message for journals that your library does not subscribe to, locate tag !57 and delete the semi-colon (;). You might want to replace the default text:
No holdings information for this record
with appropriate text such as:
The library does not subscribe to this
journal. Please ask library staff
for help in getting this article.
Chapter 3

MacSPIRS Basics

This chapter introduces you to the basics of MacSPIRS, including:

- Starting MacSPIRS
- Selecting a database to search
- Finding and showing records
- Using the Index
- Using the Thesaurus
- Getting online help
- Ending a search session

This chapter assumes that MacSPIRS has been installed on your computer. See Chapter 2, “Installing MacSPIRS” if necessary.

Starting MacSPIRS

To start MacSPIRS, double-click on the MacSPIRS icon in the folder in which it was installed. To make MacSPIRS more accessible, you may want to make an alias for MacSPIRS and drag it to your desktop or the Apple Menu Items folder. If necessary, refer to the Macintosh documentation for information on the Apple menu and making aliases.

After you launch MacSPIRS, you can select the database(s) you want to search.
Selecting a Database

When you start MacSPIRS, it displays a database title screen or database selection screen, depending on how many databases are available.

If only one database is available

If only one database is available, MacSPIRS automatically displays the database title screen as shown below. This screen provides the coverage dates, scope, and copyright information for the current database. The title screen disappears once you perform a search.

![Database Title Screen](image)

*FIGURE 3-1 The Database Title screen*

If multiple databases are available

If multiple databases are available, MacSPIRS displays the database selection list. Depending on the source and type of available databases, this list includes the server name (for network databases), database names, and coverage dates (if available). A separate text area below the selection list displays any available information about the currently highlighted database.
FIGURE 3-2 The Database Selection screen

To select databases from the list:

1. Click on the title of each database you want to select. A check mark appears to the left of each selected title. Alternatively, you can use the arrow keys to move the highlight bar through the list and press [Enter] to select titles.

2. If necessary, click Clear Selections to clear all database selections. You can also click Refresh to update the selection list after removing or loading databases.

3. Click OK. MacSPIRS displays the first database title screen and the Title Screen dialog box shown below. (You only see this screen if you select more than one database.)

FIGURE 3-3 The Title Screen dialog box

4. Click Next Title Screen and Previous Title Screen to view the remaining title screens.

5. Click Find Records to open the Find Records dialog box and begin your search.
Exchanging Databases

If the **Allow users to exchange databases** option is enabled during MacSPIRS installation, you can change the databases you want to search. (Refer to “Selecting Software Options” on page 2–8 for more information on the **Allow users to exchange databases** option.)

The procedure for exchanging databases differs depending on whether you are working with a single CD-ROM drive or with multiple CD-ROM drives and/or database servers.

**Exchanging Databases in a Single-Drive System**

To exchange databases on a Macintosh that has one CD-ROM drive:

1. Select **Exchange Databases** from the **File** menu. MacSPIRS displays the database selection screen.
2. Click on the name of the database to remove and click **Eject**.
3. Remove the disc containing the old database and insert the new disc.
4. Click on the name of the new database in the database selection window and click **OK**.

**Exchanging Databases in a Multiple-Drive System**

To exchange databases on a Macintosh that has multiple CD-ROM drives and/or is networked to a database server:

1. Select **Exchange Databases** from the **File** menu. MacSPIRS displays the database selection window.
2. From the database selection window, you can select a database that is already loaded or replace a local database with a new one.
   - To select a different database that is already loaded, click on the name of the database and click **OK**.
   - To replace a database loaded on a local CD-ROM drive, click on the name of the database and click **Eject** (the button is only active when a local database is highlighted.) Replace the old disc with the disc containing the new database, click on the name of the new database, and click **OK**.

**Note:** If you exchange databases, your search history is retained, allowing you to reuse any of the searches on the new database. MacSPIRS displays a message in the Search History window that reads “Searches above from:” and is followed by the title of the database you removed. To reuse a search, hold down the **Option** key and highlight the
text of the search. MacSPIRS retypes the search in the Find Records dialog box, so that you can use it to search in the new database.

![Search History](image)

**FIGURE 3-4 Reusing a search on a new database**

For more information on search histories, refer to “Using the Search History” on page 4–21.
MacSPIRS at a Glance

The following sections illustrate key MacSPIRS components and the basic flow of the search process. The examples show you how to find and show records as well as use the Index and Thesaurus.

Finding and Showing Records

Once you select a database, MacSPIRS displays the database title screen and Find Records dialog box. The Find Records dialog box is where you type terms to search for in the database. MacSPIRS displays the results in the Search History window and the records containing your search term in the Retrieved Records window.
1 Type a search term or phrase in the Find Records dialog box and click Start Search.

2 MacSPIRS displays your search request, and any previous requests, in the Search History.

3 MacSPIRS displays your search results in the Retrieved Records window. Click on any record number to select records for showing, printing, or saving.

4 Click Next Record and Previous Record, or use the scroll bar in the Retrieved Records window, to view retrieved records.

Refer to “Using the Find Records Dialog Box” on page 4–2 and “Showing Records” on page 5–1 for more information on finding and showing records.
Using the Index

The Index lists all of the searchable terms in the database, and indicates the number of records that contain each term. In addition to the Free Text Index, some databases have separate indexes for certain fields such as Title or Author.

As shown in the following example, the Index is especially useful for looking up hyphenated phrases.

1. Select Browse Index from the Search menu.

2. If the database you are searching has more than one Index, MacSPIRS displays the List of Available Indexes window. Click on the short name of each index you want to select and click OK.

3. MacSPIRS displays the Index window and the Browse Index dialog box.

4. Type a term or phrase at the Look Up: prompt and click Browse Index.

Refer to “Using the Index” on page 4–12 for more information on using the Index.
Using the Thesaurus

Many SilverPlatter databases include a Thesaurus, which is a list of controlled vocabulary terms used to standardize the indexing in the database. You can use the Thesaurus to select and search for synonyms, related terms, and preferred terms.

1. Select Browse Thesaurus from the Thesaurus menu.

2. Type a search term or phrase in the Browse Thesaurus dialog box and click Browse Thesaurus.

3. MacSPIRS displays the List of Permuted Terms and the Permuted Terms dialog box.

   Click on any term to search for it, add it to a list of terms for batch searching, or get term details.

4. Click Enter another word to look up another term using the Browse Thesaurus dialog box.

Refer to “Using the Thesaurus” on page 4-15 for more information on using the Thesaurus.
Getting Online Help

There are several kinds of help available in MacSPIRS. Context sensitive help provides information on specific elements of MacSPIRS. The Help menu provides general information on using MacSPIRS as well as specific help on the loaded database(s).

Context Sensitive Help

Context sensitive help offers assistance on specific elements of MacSPIRS, such as buttons, dialog boxes, and menu items.

To use context sensitive help:

1. Click the Help icon near the bottom right of most dialog boxes. The arrow pointer changes to a question mark.
2. Click on the item you want to find out about. MacSPIRS displays an explanation of the item.

![Help on NEAR](image)

*FIGURE 3-5 A typical context sensitive help window*

3. Continue to click on other items as necessary for additional help.
4. Click the Help icon again or click the help window’s close box to leave Context Sensitive Help and recover the arrow pointer.

Menu Help

The Help menu provides information on search techniques, the loaded database(s), and how to use the help system.

To use the Help menu:

1. Select a topic or subtopic from the Help menu:
   - **Help on SilverPlatter Help** instructs how to use the Help menu.
• **MacSPIRS Help Topics** offers general advice on using MacSPIRS.

• **MacSPIRS Help Keywords** lists the key words and phrases used in the MacSPIRS Help Topics.

• **List Databases and Fields** displays a list of all databases and fields currently in use. (For more information, refer to “Database and Field Information” on page 3–12.)

• **Guide Topics** provides a list of Help topics for the loaded database(s).

• **Guide Fields** lists the fields contained in the loaded database(s).

• **Guide Keywords** lists the key words and phrases used in the Guide Topics.

2. MacSPIRS displays the topic you select. If necessary, resize the Help Window or scroll through the text.

   ![Running Saved Search Histories](image)

   **FIGURE 3-6 A typical Help window**

3. Click on a link to jump to another topic.

4. You can return to a previous Help window, provided it is still open, in the following ways:
   • Click the close box of the current Help window.
   • Click on any visible portion of the previous Help window.
• If a bullet (•) appears to the left of the current Help topic title, you can hold down the Command key [ • ] and press [B], or select Previous Topic from the Help menu.

5. Close the Help windows, or leave them open for reference, and return to what you were doing.

Database and Field Information

At any point during your work session, you can use the List Databases and Fields menu command to get information on the current database and fields.

• Select List Databases and Fields from the Help menu. MacSPIRS displays the Database(s) and Fields window showing all current databases and their fields. If more than one database is in use, the fields are divided into Universal Fields (those common to all databases) and database specific fields. You may need to use the scroll bars to see all the field names.

![Database(s) and Fields window](image)

**FIGURE 3-7 Database(s) and Fields window**

To use a field name as part of a search request:

• Hold the Option key and click on the field’s short name; MacSPIRS places the short name in the Find Records dialog box. (When searching in a field, always use the field’s short name in your search request.)
To get a description of a particular field:

- Click its full field name. MacSPIRS displays a window containing an example and brief description of the field. Click this window’s close box to return to the Database(s) and Fields window.

![FIGURE 3-8 A typical field description Help window](image)

### Ending a Search Session

When you are finished searching, you can quit MacSPIRS and return to the Desktop or restart MacSPIRS for the next user.

#### Quitting MacSPIRS

To quit MacSPIRS, select **Quit** from the **File** menu. MacSPIRS clears the Search History window, restores all options and window sizes to their defaults, and closes. You return to the Macintosh Desktop.

#### Restarting MacSPIRS

To restart MacSPIRS, select **Restart Session** from the **File** menu. MacSPIRS restores all options and window sizes to their defaults, and displays the database selection screen.
Chapter 4

Searching with MacSPIRS

You can search for records in a variety of ways, depending on your search concepts, the database you are searching, and your preferences. This chapter illustrates various ways of using the Find Records dialog box to search databases:

- Performing a Simple Search
- Valid Search Statements
- Using Truncation and Wildcards
- Searching for Hyphenated Phrases
- Using Parentheses
- Combining Terms with Operators
- Searching in Specific Fields
- Searching in Limit Fields
- Using the Suggest Feature

The second part of the chapter addresses some of the more advanced MacSPIRS functions:

- Using the Index
- Using the Thesaurus
- Using the Search History
- Using Current Awareness Searches: SDIs and Alerts
- Searching Multiple Databases
- Narrowing and Broadening Your Search
Using the Find Records Dialog Box

The first step in a search is to decide what you are searching for. Identify terms or concepts that describe your search objective. Once you have your topic, think of the search terms that represent the search topic.

Next, evaluate your search terms in relation to the database: do they adequately describe the topic? Will they be too specific or too general? The answers to these questions depend on many factors, including the scope of the database you choose to search.

Once you identify the objective of your search, you can determine how to search the database. The simplest way to search is described below.

Performing a Simple Search

To search for a term of phrase:

1. Type a search request in the Find Records dialog box.

   ![FIGURE 4-1 Searching for “blood pressure”]

2. Click Start Search. MacSPIRS lists the results of your search in the Search History window.

   ![FIGURE 4-2 Results of the search for “blood pressure”]

   **Note:** The results of the individual terms of the phrase (for example, “blood” and “pressure”) are included if you have the Show Intermediate Results option turned on in the Search menu.

3. If necessary, click Show Records Found in the Find Records dialog
box. MacSPIRS displays the records retrieved by your search.

![Retrieved Records Table]

FIGURE 4-3 Records retrieved by a search for “blood pressure”

Note: The records are displayed automatically if you have the Immediate Record Display option turned on in the Options for Show dialog box.

Refer to the following sections in this chapter for information on refining your search. Remember online help is available: click on the help icon in any dialog box or use the Help menu.

Valid Search Statements

Below are examples of search requests that you can type in the Find Records dialog box. Each request can be up to 1024 characters long.

<table>
<thead>
<tr>
<th>Description of Search</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>A term</td>
<td>dog</td>
</tr>
<tr>
<td>A term with truncation</td>
<td>comput*</td>
</tr>
<tr>
<td>A term with wildcards</td>
<td>colo?r</td>
</tr>
<tr>
<td>A number</td>
<td>1994</td>
</tr>
<tr>
<td>Letters and numbers combined</td>
<td>3m</td>
</tr>
</tbody>
</table>

(Sheet 1 of 2)
<table>
<thead>
<tr>
<th>Description of Search</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>A phrase</td>
<td>new york city</td>
</tr>
<tr>
<td>A hyphenated phrase</td>
<td>drug-abuse</td>
</tr>
<tr>
<td>A phrase with operators in quotes</td>
<td>“near” death experience</td>
</tr>
<tr>
<td>A term or phrase limited to a field</td>
<td>smith in au</td>
</tr>
<tr>
<td>A previous search request number</td>
<td>#3</td>
</tr>
<tr>
<td>Any of the above, combined with operators</td>
<td>3m and #2</td>
</tr>
<tr>
<td>Any of the above, separated by semi-colons</td>
<td>drug-abuse;#4;smith in au</td>
</tr>
<tr>
<td>Any of the above, grouped with parentheses for clarity</td>
<td>(canine or #1) near puppy</td>
</tr>
</tbody>
</table>

**Using Truncation and Wildcards**

You can retrieve variations of a search term by using truncation and wildcards. This is a useful means of broadening a search that has retrieved too few records.

The truncation symbol (*) serves as a substitute for any string of zero or more characters. For example, type cardio* to retrieve cardiology, cardiogram, etc.

The wildcard symbol (?) serves as a substitute for one character or none. For example, type m?cdonald to retrieve McDonald or MacDonald.

The truncation and wildcard symbols can be used anywhere in your search term, except as the first character.

**Searching for Hyphenated Phrases**

Often, when a database is set up, the individual words of a phrase are “bound” with hyphens so that the complete phrase can be indexed, rather than just the individual words. For example, authors’ names are hyphenated so that the first and last names are kept together in the Index. Similarly, controlled vocabulary terms, such as descriptors, are hyphenated so that key phrases are kept intact.
When searching a field that uses hyphens, you can include them in or omit them from your search request to make the search more or less focused. To determine which fields use hyphens, take note of the fields in a retrieved record or refer to the database Guide in the Help menu.

**Including Hyphens for a Focused Search**

If the field you are searching uses hyphens, you can hyphenate your search term to retrieve only occurrences of that term.

For example, if you are searching the Descriptors (DE) field, the search request marine-aquaculture in de retrieves only occurrences of marine-aquaculture. Similarly, in the Authors (AU) field, the search lindeman-c in au retrieves only records authored by C. Lindeman.

Alternatively, you can select hyphenated phrases from the Index. Refer to “Using the Index” on page 4–12 for more information.

**Omitting Hyphens for a Broad Search**

If the field you are searching uses hyphens, you can omit them from your search term to retrieve variations of your term. For example, if you are searching the Descriptors (DE) field, the search request marine in de retrieves occurrences of marine, marine-aquaculture, marine-crustaceans, marine-environments, etc. Similarly, in the Authors (AU) field, the search lindeman in au retrieves records authored by A.K. Lindeman, C. Lindeman, C.A. Lindeman, etc.

**Using Parentheses**

Use parentheses to avoid ambiguity in complex search statements.

For example, suppose you want to retrieve records that discuss rabies in dogs or rabies in cats.

The search request rabies and dogs or cats retrieves records that discuss rabies and dogs, and records that discuss cats, but not necessarily records that discuss rabies and cats.

The search request rabies and (dogs or cats) retrieves records that discuss rabies and either dogs or cats, which is what you intended.

If you omit parentheses from a complex search statement, MacSPIRS automatically inserts them. Check the Search History window to see if MacSPIRS’ interpretation is what you intended. If it is not, click the
**Break** button displayed with the search progress message, and edit the search request.

**Combining Terms with Operators**

Operators are words that have a special meaning in MacSPIRS. You can use them to combine search terms into a more complex search statement.

<table>
<thead>
<tr>
<th>Operator</th>
<th>What It finds</th>
</tr>
</thead>
</table>
| **and**  | Records that contain both of two search terms.  
For example, *dyslexia* and *child* retrieves records containing both *dyslexia* and *child*. |
|          | *Shaded area represents records containing the term dyslexia and the term child* |
| **with** | Records that contain both of two search terms in the same field.  
For example, the search *dyslexia with research* retrieves records that contain both *dyslexia* and *research* in any one of the database fields. |
| **near** | Records that contain both of two search terms in the same sentence.  
For example, *dyslexia near treatment* retrieves only those records where *dyslexia* and *treatment* are in the same sentence (either term can appear first).  
You can add a number to **near** to specify exactly how close the terms should be. For example, *language near2 computer* retrieves records containing *language* within two words of *computer*, in any order, in the same sentence. |

(Sheet 1 of 3)
<table>
<thead>
<tr>
<th>Operator</th>
<th>What It finds</th>
</tr>
</thead>
<tbody>
<tr>
<td>adj</td>
<td>Records that contain two adjacent terms in the order you specify. For example, the focus of the search <em>racing bicycle</em> is different from that of <em>bicycle racing</em>. The adjacent operator means MacSPIRS searches for the two terms in the order you specify, thus preserving the focus of your search. adj also lets you search for identical, adjacent terms, such as “gorilla adj gorilla.” This is useful for searching biological classifications, in which several organisms have identical genus and species names, such as “bufo bufo.” You cannot use adj to combine the current search with a previous one.</td>
</tr>
<tr>
<td>or</td>
<td>Records that contain either or both of two search terms. For example, the search <em>dyslexia or learning disabilities</em> retrieves all records that contain <em>dyslexia</em>, <em>learning disabilities</em>, or both <em>dyslexia</em> and <em>learning disabilities</em>.</td>
</tr>
</tbody>
</table>

Shaded areas represent records containing the term dyslexia or the term learning disabilities

(Sheet 2 of 3)
Operator | What It finds
--- | ---
not | Records that contain the first of two search terms, but not the second. This can be helpful for eliminating false hits.

For example, truman not capote retrieves records that contain Truman and do not contain Capote (references to the president but not the writer.)

not should be used carefully, however, because it can also eliminate useful records.

For example, if you search for dog not puppy, you will miss records that discuss both dog and puppy.

Grey area represents records retrieved by dog not puppy; Black area represents relevant records eliminated by dog not puppy

To combine terms with an operator:

1. Enter your first term in the Find Records dialog box.
2. Click the button of the operator you want to use. MacSPIRS places the operator after your first term.

   ![Find Records dialog box](image)

   FIGURE 4-4 Adding an operator to a search request

   Alternatively, you can type the operator after your first term.
3. Enter your second term after the operator.
4. Click Start Search.
Searching in Specific Fields

You can narrow your search by limiting it to a particular field or group of fields in the database. By searching only in relevant fields, you can eliminate false hits.

For example, suppose you are looking for the works of a particular author. Rather than search the entire database, you can search only those fields that contain author information, such as the Author (AU) and Corporate Author (CA) fields.

To search in a specific field:

1. In the Find Records dialog box, type a term or phrase followed by in and the short name of the field you want to search.

   For example, to search for Freud in the Author (AU) field, type freud in au.

   ![Find Records Dialog](image)

   **FIGURE 4-5 Searching in the AU field**

   To search in multiple fields, separate the labels with commas, such as freud in au, su.

2. Click **Start Search**.

   You can also select field labels from a list and add them to your search:

   1. Type a term or phrase in the Find Records dialog box and click the in button; MacSPIRS displays the Database(s) and Fields window.
2. Hold down the **Option** key and click on the short name of the field you want to search. MacSPIRS places the short name in the Find Records dialog box.

3. Click **Start Search** in the Find Records dialog box.

Field-specific indices also provide a way to search particular fields. For more information, refer to “Using the Index” on page 4–12.

**Searching in Limit Fields**

Limit fields are specially indexed fields that contain relatively few possible values. They allow you to limit your search results to records of a particular characteristic, such as language of text or date of publication.

You can search limit fields with the **in** or **=** operator.

For example, if the database you are searching contains a Language (LA) field, you can retrieve German documents by typing `german in la` or `la=german`.
Some limit fields, usually those containing numeric information, can also be searched with the following operators. These allow you to search for a range of records, such as all records published between 1992 and 1994.

<table>
<thead>
<tr>
<th>Operator</th>
<th>What it Means</th>
<th>Search Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;</td>
<td>less than</td>
<td>py&lt;1986</td>
</tr>
<tr>
<td>&gt;</td>
<td>greater than</td>
<td>py&gt;1984</td>
</tr>
<tr>
<td>&lt;=</td>
<td>less than or equal</td>
<td>py&lt;=1985</td>
</tr>
<tr>
<td>&gt;=</td>
<td>greater than or equal</td>
<td>py&gt;=1984</td>
</tr>
<tr>
<td>-</td>
<td>within a range</td>
<td>py=1983-1986</td>
</tr>
</tbody>
</table>

To search in a limit field:

1. In the Find Records dialog box, type the label of the field you want to search, such as py.
2. Type = or, if applicable, one of the range operators.
3. Type an appropriate search term. Your search request should resemble py>1993, an=105899, or la=french.
4. Click Start Search.

For a list of the limit fields in the database you are searching, select List Databases and Fields or the database Guide from the Help menu.

**Using the Suggest Feature**

The Suggest feature, or Automatic Subject Lookup, provides you with a list of suggested terms related to your search request. These suggested terms are taken from the database’s controlled vocabulary and appear in a window that lets you search or display definitions.

Suggested terms are available only with certain SilverPlatter databases, and only if you are searching a single database. The Suggest button will not appear in the Find Records dialog box if the feature is unavailable.

To display a list of suggested terms:

1. Type a single term or phrase in the text entry box of the Find Records dialog box. (Multiple terms combined with operators or semi-colons are not allowed.)
2. Click **Suggest.** MacSPIRS displays a list of suggested terms.

![Screenshot of the Suggest dialog box](image)

**FIGURE 4-7 The Suggests dialog box**

3. Select a suggested term from the list.

4. If you want to see a definition for the selected term, click **Definition,** then click **OK** to return to the Suggestions dialog box.

5. Search for the suggested term:
   - Click **Explode** to search for the term and all narrower terms.
   - Click **Search** to search for the term without any narrower terms.

### Using the Index

The Index lists all the searchable terms in the database and indicates the number of records that contain each term. Many databases have more than one index. For example, a database can have an index for the Author field, and a separate index for the Title field. The Index is especially useful for finding hyphenated phrases and variations of authors’ names.

**Note:** Words that appear too frequently to be used in searching are omitted from the Index; these are called “stopwords” and are listed in the database **Guide** in the **Help** menu.
To select terms from the Index:

1. Select **Browse Index** from the **Search** menu, or hold down the **Command** key [\*] and press [I].

2. If the database contains more than one index, MacSPIRS displays the List of Available Indexes. For a description of an index, click on its long name.

   ![List of Available Indexes](image)

   **FIGURE 4-8 The List of Available Indexes window**

3. Click on the short name of each index you want to select and click **OK**.

4. MacSPIRS displays the Browse Index dialog box and the Index window. In the text entry area of the Browse Index dialog box, type a term or phrase. Use the **Erase** button to clear any mistakes.

   ![Browse Index dialog box](image)

   **FIGURE 4-9 The Browse Index dialog box**

5. Click **Browse Index** and the term you typed (or its closest equivalent) appears at the top of the Index window.
FIGURE 4-10 The Index window

6. Browse the Index using the vertical scroll bar. Resize the Index window or use the horizontal scroll bar to view terms that extend beyond the right-hand boundary of the Index window.

7. Select any term or phrase by holding the Option key and clicking on or dragging across it. MacSPIRS places the selection into the Find Records dialog box. Multiple entries are connected with the or operator.

Changing Indexes

If the database you are using has more than one index, you can change indexes as follows:

1. Click Change Index in the Browse Index dialog box or choose Select Index from the Search menu. MacSPIRS displays the List of Available Indexes window.

2. Click on the short name of each index you want to select and click OK.
Using the Thesaurus

Many databases include a thesaurus, which is a list of controlled vocabulary terms used to standardize the indexing in the database. The Thesaurus enables you to select and search for synonyms, related terms, and preferred terms. If the thesaurus is arranged hierarchically, you can select more general (broader) and more specific (narrower) terms.

Some thesauri provide subheadings that help you to narrow your search. For example, if you are searching for malaria, you could apply the subheadings etiology and drug-therapy to make your search more specific.

Some thesauri allow you to explode your search terms. With this feature, MacSPIRS searches for records that contain your search term or any of its narrower terms.

Looking Up a Thesaurus Term

To look up a thesaurus term:

1. Choose Browse Thesaurus from the Thesaurus menu. MacSPIRS displays the Browse Thesaurus dialog box.

![Figure 4-11 The Browse Thesaurus dialog box](image)

2. Type a word, word root, or phrase to look up and click Browse Thesaurus. MacSPIRS displays the Permutated Terms dialog box and list of Permutated Terms, with your term or its closest match highlighted.
3. Scroll through the List of Permutated Terms. It lists all the descriptor phrases in which each controlled vocabulary term occurs. You can get details and search for any terms of interest, and you can add terms to a list for batch searching.

4. If you need to look up another word, click Enter another word. MacSPIRS displays the Browse Thesaurus dialog box again.

Getting Details about a Selected Thesaurus Term

The MacSPIRS Thesaurus includes a Selected Term Details window, which provides details about a selected thesaurus term. The information provided depends on the database you are searching. It often includes a definition, scope notes, previous indexing terms, and related, broader, and narrower terms.

To get details about a thesaurus term:

1. If necessary, look up a term in the Thesaurus as described at “Looking Up a Thesaurus Term” on page 4-15.
2. Click on a term in the List of Permutted Terms.

3. Click **Term Details** in the Browse Thesaurus or Permutted Terms dialog box. MacSPIRS displays the Selected Term Details window and the Selected Term dialog box.

![Selected Term Details](image)

**FIGURE 4-13 The Selected Term Details window and Selected Term dialog box**

You can then search for the selected term, add it to a list of selected terms for batch searching, or display the complete tree.

**Displaying Trees**

Some thesauri display broader and narrower terms in a hierarchical structure called a “tree.” Trees are shown in abbreviated form in the Selected Term Details window.

To display the complete tree:

1. If necessary, get details about a term as described at “Getting Details about a Selected Thesaurus Term” on page 4–16.

2. Click **Display Tree** in the Selected Term dialog box. If the selected term appears in more than one tree, you will need to choose the tree
you want to display from the pop-up list. MacSPIRS displays the Trees window and Selected Tree dialog box.

![Diagram of Trees - Hierarchical Display of Terms]

**FIGURE 4-14 The Trees window and Selected Tree dialog box**

The column of numbers on the left side of the tree indicates the level of each term in the tree. Broader, more general terms are indicated by lower numbers, and are listed further left than narrower, more specific terms.

You can search for any term in the tree, get details on it, or add it to a list.

**Searching for Thesaurus Terms**

MacSPIRS allows you to search for thesaurus terms directly from the Permutated Terms, Selected Term, or Selected Tree dialog boxes. Once you select a term, you can search for it individually, or you can add it to a list of selected thesaurus terms for batch searching.

To search for thesaurus terms:

1. Select any term of interest in the List of Permutated Terms, Selected Term Details, or Selected Tree window.
2. Choose the type of search you want to perform:
   - Select **Explode Term** to search for the selected term along with its narrower, more specific terms. This is more comprehensive
than searching for the term by itself. (If the thesaurus is organized into trees, you may have to select a tree in which to explode the term. If there is a pop-up list of trees in the Selected Term dialog box, select any or all trees.)

- Select Single Term Search to search for the selected term without its narrower terms.

3. Click Search Now to perform the search, or click Add to List to add it to a list of searches to perform later.

4. If the thesaurus you are searching uses subheadings, MacSPIRS displays the Subheadings Selection window. Select one or more subheadings and click OK. Refer to “Selecting Subheadings” on page 4–20 for instructions.

5. If you chose Search Now, MacSPIRS copies the term, and any subheadings, to the Find Records dialog box and performs the search.

If you chose Add to List, MacSPIRS copies the term, and any subheadings, to the Selected Thesaurus Terms list. You can then view the list, add more searches to it, or perform all of the searches.

**If You Have a List of Searches**

Once you add a search to the Selected Thesaurus Terms list, you can view the list, add more searches to it, or perform all of the searches.

To view the list:

- Click View List in the Permutated Terms, Selected Term, or Selected Tree dialog box. MacSPIRS displays the Selected Thesaurus Terms dialog box.
To delete searches from the list:

1. Click on each search you want to mark for deletion. MacSPIRS places a bullet (*) next to your selections.
2. Click Delete Selections.

To perform the searches:

- Click Search List in the Selected Thesaurus Terms dialog box. (You can also click Search List in the Permuted Terms, Selected Term, or Selected Tree dialog box.) MacSPIRS performs all of the searches and discards the list.

**Selecting Subheadings**

Subheadings are qualifiers used in some thesauri to describe specific aspects of terms. If the database uses subheadings, you need to apply one or more to your term before searching for the term.

To select subheadings:

1. When you click Search Now or Add to List in the Permuted Terms, Selected Term, or Selected Tree dialog box, MacSPIRS displays the Subheadings Selection window. (The list of subheadings varies from database to database.)
2. For a description of any subheading, click on its long name.
3. Click on the short name of each subheading you want to select. You must select at least one.
4. Click OK.

Using the Search History

The Search History window provides a numbered list of all your search requests and indicates the number of records retrieved by each. The Search History is updated with each search request.

FIGURE 4-17 The Search History window
You can reuse or clear any search from the Search History. You can also save your history and rerun a previously saved history.

**Reusing Search Requests**

Each of your search requests is numbered and listed in the Search History window. You can reuse a search request to combine it with a new search or to show, print, or save the records retrieved by it.

To combine a previous search with a new one:

1. Hold down the **Option** key and click on the number of the desired search request in the Search History window. The number is automatically placed in the Find Records dialog box.

   Alternatively, you can type the number of the desired search request in the Find Records dialog box, such as #1. (To enter #, press the **Option** key, and [3] together.)

2. Combine the search with additional terms using the available operators. For example, you could construct a search request, #1 and freud in au.

3. Click **Start Search**. The Search History window reports the number of records retrieved by the search request.

To show, print, or save the results of a previous search:

1. Double-click on the desired search in the Search History window. MacSPIRS performs the search on the currently selected database(s).

2. If necessary, select **Show All Records** from the **Show** menu. (MacSPIRS displays the records automatically if you have the **Immediate Record Display** option turned on in the Options for Show dialog box.) Refer to “Showing Records” on page 5–1 for more information.

3. To print or save the records, select **Print Records** or **Save Records** from the **File** menu. Refer to “Printing Records” on page 5–12 and “Saving Records” on page 5–15 for details.

   You can also save all or part of your search history and run the search requests during later work sessions. Refer to “Saving a Search History” on page 4–23 for additional information.
Clearing Search Requests

MacSPIRS allows you to remove search requests from the Search History window. This is useful when you want to start a new set of searches. Once you have cleared a search request, you cannot recover it.

To clear search requests from Search History window:

1. Select **Clear Searches** from the **Search** menu. MacSPIRS displays the Clear Searches dialog box.

   ![Clear Searches dialog box](image)

   **FIGURE 4-18 The Clear Searches dialog box**

2. Enter the search requests you want to clear. You can enter a single request, a nonconsecutive group, or a range of requests.

3. Click **OK**. MacSPIRS renumbers the remaining search requests.

Saving a Search History

Once you complete a search, you can save any of your search requests (search history) and run them during future work sessions. Stored search histories are especially useful for complex searches, or those you perform regularly.

To save your search history:

1. Select **Save Search History** from the **File** menu. MacSPIRS displays the Save Search History dialog box.
FIGURE 4-19 The Save Search History dialog box

2. Enter the numbers for the search requests you want to save. You can save a single request, a nonconsecutive group, or a range of requests.

3. Enter a description of the search history.

4. Enter the startup database(s) or database family you want MacSPIRS to access when you run the search history. You can type this information manually, or you can use the Current Database and Current Family buttons to enter the current codes automatically. If you want to select databases as normal when you run the search history, leave this field blank.

5. Click OK. MacSPIRS displays the standard Macintosh Save dialog box.

6. Specify a name and destination for the search history file.

7. Click Save.

Running a Saved Search History

To run a previously saved search history:

1. Select Run Search History from the File menu. MacSPIRS displays a standard Macintosh dialog box that allows you to locate your search history files.

2. Select the search history file you want to open.

3. Select Run Saved Searches.
4. Click **Open**. MacSPIRS runs the search against the database(s) specified in the Save Search History dialog box.

5. If the specified database is not found, MacSPIRS lets you select another database from the Database Selection screen.

   **Note:** You can also start MacSPIRS and run a saved search at the same time. Simply double-click on any search history (.his) file stored on the hard disk or diskette.

To edit a search history file:

1. Select **Run Search History** from the **File** menu. MacSPIRS displays a standard Macintosh dialog box that allows you to locate your search history files.

2. Select the search history file you want to edit.

3. Select **Show Description/Edit Searches**.

4. Click **Open**. MacSPIRS displays the Saved Search History dialog box.

   ![Screenshot of the Saved Search History dialog box]

   **FIGURE 4-20 The Saved Search History dialog box**

5. Edit the Search History Description or Startup information as needed.

6. If you want to edit the search requests in the file, click **Edit Searches**. The Edit Searches dialog box opens, listing all search
requests in the history file.

![Edit Searches dialog box](image)

**FIGURE 4-21 The Edit Searches dialog box**

7. Edit the search requests.

   **Note:** MacSPIRS does not check for proper syntax, so if you are unfamiliar with search histories, you should not edit them. In particular, you cannot edit a search so that it contains implicit, or nonexistent, refer-backs.

8. Click **OK** to return to the Saved Search History dialog box.

9. Click **OK** in the Saved Search History dialog box to save your changes.

**Using Current Awareness Searches: SDIs and Alerts**

Your MacSPIRS administrator may have set up MacSPIRS in your organization so that you can use “current awareness searches”. These are searches that the system runs automatically, at regular intervals, and then emails the results to you. There are two types of current awareness searches: SDIs, and Alerts.

With SDIs, *(Selective Dissemination of Information)* you create and save your own searches and the system runs them automatically. You specify the interval at which you want the search to be rerun and give your email address so that search results are mailed to you. You create an
SDI search in MacSPIRS, then, when you choose the Save as SDI menu item, MacSPIRS automatically establishes a link to WebSPIRS, where you set up the SDI.

With Alerts, authorized users can subscribe to a selection of searches created by your MacSPIRS administrator or librarian. These searches are run periodically, and the results emailed to users who have subscribed to the Alert service.

Ask your MacSPIRS administrator if you are not sure whether you have access to SDIs or Alerts.

**SDI Menu Items**

If you have been authorized to use SDIs and Alerts, your MacSPIRS 4.0 screen contains new File menu items that function with the SDI feature. (These menu items are not available if SDIs have not been authorized.

<table>
<thead>
<tr>
<th>Use this File Menu Item</th>
<th>To do this</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Save as SDI</strong></td>
<td>Set up an SDI. After conducting a search and choosing this menu item, MacSPIRS 4 links automatically to WebSPIRS and displays the Create SDI screen.</td>
</tr>
<tr>
<td><strong>Show SDI Account</strong></td>
<td>Edit or administer existing SDIs by linking to WebSPIRS to view an account you set up previously.</td>
</tr>
<tr>
<td><strong>Alert Service</strong></td>
<td>View and subscribe to alerts by linking to WebSPIRS.</td>
</tr>
<tr>
<td><strong>SDI Setup</strong></td>
<td>View and edit the settings you use to access WebSPIRS.</td>
</tr>
</tbody>
</table>

**Creating an SDI from MacSPIRS**

To create an SDI:

**Note:** The databases you select for a MacSPIRS search must also be available on the WebSPIRS server that runs the SDIs. Ask your MacSPIRS administrator if you are unsure about this.

1. Carry out one or more searches in MacSPIRS.
2. Revise your search until it meets your needs for an SDI.
3. Choose **Save as SDI...** from the **File** menu. This launches a browser connection to WebSPIRS 4.0.

4. Follow the WebSPIRS online help for creating the SDI.

**Editing SDI Settings**

To edit SDI settings:

1. Choose **SDI Setup...** from the **File** menu to open the SDI Setup dialog box.

![SDI Setup dialog box](image)

**FIGURE 4-22 SDI Setup dialog box**

2. Your MacSPIRS administrator entered default settings when authorizing SDIs. Change these settings only if you have been told to do so.

   - At **WebSPIRS Address** enter the URL for the version of WebSPIRS you are using to access SDIs.
   - At **User ID** and **Password** enter the user id and password you have been told to use for accessing SDIs.

3. Click **OK** to save your changes.

**Subscribing to an Alert**

Your MacSPIRS administrator may have set up some Alerts. These are pre-configured searches, similar to SDIs, that you can subscribe to, and have the search results emailed to you automatically by the system.
To subscribe to an alert:

1. Choose **Alert Service**, from the **File** menu. This opens a browser, and connects to WebSPIRS.

2. In the WebSPIRS Alerts screen, choose any Alerts you want to subscribe to, and enter your email address.

   See the WebSPIRS online help for more information about subscribing to Alerts.

### Searching Multiple Databases

With MacSPIRS, you can search more than one database at a time. When doing so, you must keep the following in mind:

- The databases may not have all fields in common; if you search in a specific field (either in the Find Records dialog box or in the Index), you can only retrieve records from those databases that contain the field.
- The Thesaurus is unavailable, even if each of the selected databases has a Thesaurus.
- The Suggestions feature is unavailable.
- Each database has its own set of Guides in the **Help** menu.

Refer to “Selecting a Database” on page 3–2 for instructions on selecting multiple databases.

### Narrowing and Broadening Your Search

If your initial search request retrieves too many or too few records, you can narrow or broaden the search using the following techniques. These are discussed further in other sections of this chapter.

To narrow your search:

- Search in a specific field (see page 4–9)
- Search in a limit field (see page 4–10)
- Combine your search with additional terms using the **and, near, not,**
adj. and with operators (see page 4–6)

- Select more specific terms from the Index or Thesaurus (see page 4–12 and page 4–15)

To broaden your search:

- Use truncation and wildcards to retrieve variations of your search terms (see page 4–4)
- Combine your search with additional terms using the or operator (see page 4–6)
- Select broader terms from the Index or Thesaurus (see page 4–12 and page 4–15)
- Search multiple databases (see page 4–29)
Chapter 5

Using Retrieved Records

Once you have searched for and retrieved records of interest, you have several options, including displaying, printing, and saving records, and marking a subset of records. You can also output records in a variety of formats by changing the Show, Print, and Save options.

Showing Records

MacSPIRS displays records automatically after each search if you have the **Immediate Record Display** option turned on in the Options for Show dialog box. For faster searching, you can turn this option off, and then show records in one of the following ways:

- Use the up and down arrows to highlight the search you want, and click **Show Records Found** in the Find Records dialog box.
- Double-click on any search in the Search History; MacSPIRS highlights the search and displays the records in the Retrieved Records dialog box.

Changing Show Options

The Options for Show dialog box allows you to select fields and field labels, and control the immediate record display feature.

1. Select **Options for Show** from the **Show** menu. MacSPIRS displays the Options for Show dialog box.
2. If necessary, click **Select Fields** to select the fields you want to show. See “Showing a Subset of Fields” on page 5–4 for instructions on selecting fields.

3. Your selections will remain in effect until you reset them, or until you quit or restart MacSPIRS, unless you check the **Remember Field Selections** option.

   Check **Remember Field Selections** if you want MacSPIRS to remember the field settings you have selected, and show only those fields for all records you retrieve from any database. (See “Showing a Subset of Fields” on page 5–4 for instructions on selecting fields.)

   If you want MacSPIRS to use your field selections for only the database you are using now, and any member of that database family, check both **Remember Field Selections** and **DB Qualify Fields**.

   This information is stored with your preferences. Next time you start MacSPIRS, or exchange databases, you see a message saying that your preferences override the entry in your configuration file (your .ini file). If you only checked **Remember Field Selections** MacSPIRS shows records with the fields you have selected. If you checked both options, MacSPIRS displays records with all fields, except for the database family that was current when you checked the **DB Qualify Fields** option. For that database family, MacSPIRS uses only your selected fields.

4. Select the **Field Labels** option you want:
   * Click **Long** to display records with full field names, such as
“Title.”

- Click Short to display records with abbreviated field names, such as “TI” for the “Title” field. MacSPIRS displays retrieved records with short field labels by default.
- Click None to display records without field names.

5. Uncheck Immediate Record Display to prevent MacSPIRS from displaying records automatically after each search.

Note: You can also disable the immediate record display default through the macspirs.ini file. For more information, see “Configuring MacSPIRS” on page 2–12.

6. Click OK.

**Showing a Subset of Records**

If your search yields a large number of records, you can show a more precise subset of records.

1. Click Show Subset in the Show Records dialog box. MacSPIRS displays the Show Subset dialog box.

   ![FIGURE 5-2 The Show Subset dialog box](image)

2. Select one of the subset options:
   - Click Selected Records to show only selected records. (This option is disabled if you haven’t selected any records. Refer to “Selecting Records” on page 5–9 for more information.)
   - Click Current Search to show all records retrieved from the currently highlighted search in the Search History window.

3. If you want to skip to a particular record within the subset, type the number of the record in the Skip to Record # box. This number must not be greater than the number of records found and, if you have chosen to display a subset of selected records, the number specified must correspond to one of the selected records.
Showing a Subset of Fields

The Select Fields dialog box allows you to choose the fields you want to include when displaying records. You can select and show all fields, or a particular subset of fields.

To show a subset of fields:

1. Click **Select Fields** in either the Show Records or Options for Show dialog box. MacSPIRS displays the Select Fields dialog box which lists all of the fields and fieldsets available for selection.

2. If you want to see a description and search example for a field, click on its long name.

3. Click on the short name of each field you want to show. MacSPIRS places a check to the left of your selections. Note that if you select a fieldset, MacSPIRS places a check to the left of all of the fields that make up the set.
   - To display all fields, select **ALL Fields**.
   - To display most fields, select **ALL Fields** and then deselect those fields that you do not want to display.
   - To display only fields that contain one of your search terms, select **Hits**. “Hits” are occurrences of your search terms in retrieved records. Since hits occur in different fields from one record to the next, selecting **Hits** is the most efficient way of displaying all occurrences of your search terms.

4. If you want to deselect a field, click again on its short name.
MacSPIRS removes the check.

To clear all field selections at once, click **Clear**. However, you must make at least one field selection before clicking **OK**.

5. Click **OK** when you have selected the fields you want to display.

**Sorting Records**

MacSPIRS lets you sort retrieved records by a specific field. You can sort the fields in ascending or descending order.

To sort records:

1. Select **Sort Records** from the **Show** menu, and choose one of the submenu options:
   - Select **Records from Search** to sort records from the current search. (This option is available only if your search retrieves 1,000 records or fewer.)
   - Select **Selected Records** to sort selected records. (This option is disabled if you haven’t selected any records. Refer to “Selecting Records” on page 5–9 for more information.)

MacSPIRS displays the Sort Records dialog box.

![FIGURE 5-4 The Sort Records dialog box](image)

2. Select the field you want to use to sort the records.

3. Select one of the sorting options:
   - Click **Not Sorted** to undo the last sort and display records in
their original order.

- Click **Ascending** to sort in ascending order (1-100; A-Z).
- Click **Descending** to sort in descending order (100-1; Z-A).

4. Click **OK**. MacSPIRS displays the sorted records in the Retrieved Records window.

**Searching from Retrieved Records**

You may see a word or phrase in a retrieved record that suggests an alternative search strategy. You can select the terms for searching and MacSPIRS automatically places them in the Find Records dialog box. This process is often referred to as “lateral searching.”

To conduct a lateral search:

1. Browse through the retrieved records using the scroll bar and the **Next Record** and **Previous Record** buttons.

2. When you identify a term in one of the records that suggests another search, hold down the **Option** key and click on or drag across the term. MacSPIRS places that term in the Find Records dialog box, followed by the short name of the field from which the text was selected.

   If a term already exists in the dialog box, MacSPIRS adds the **or** operator before adding the new term.

3. Click **Start Search**.

**Displaying Hotlinked Records**

In some SilverPlatter databases, records may be linked to other relevant records. These links, called hotlinks, appear as underlined text within records. If you retrieve a record that contains hotlinks, you can show, print, and save the linked records.

The database **Guide** in the **Help** menu may tell you if the database you are searching has hotlinks.

To show a hotlinked record:
1. Click on the hotlink text. MacSPIRS displays the linked record in the Retrieved Records window.

2. If there are links within this record, you can click on the hotlink text to see them.

3. Click **Back(#)** in the Show Records dialog box to move backward through the linked records you have viewed. Alternatively, click **Back to Origin** (available after two or more links) to return immediately to the original record.

![Show Records dialog box](image)

**FIGURE 5-5 The Show Records dialog box (for hotlinked records)**

To print a hotlinked record:

1. Show a hotlink record as described above.

2. Select **Print Records** from the **File** menu or hold down the **Command** key and press [P]. MacSPIRS displays the Print Records dialog box. The **Hotlink** option is automatically selected.

3. Change the other print settings if necessary.

4. Click **Print**.

Refer to “Printing Records” on page 5–12 for more information.

To save a hotlinked record:

1. Show a hotlink record as described above.

2. Select **Save Records** from the **File** menu. MacSPIRS displays the Save Records dialog box. The **Hotlink** option is automatically selected.

3. Change the other dialog settings if necessary.

4. Click **Save...**. MacSPIRS displays the Macintosh File Save dialog box.

5. Specify a file name and destination, then click **Save**.

See “Saving Records” on page 5–15 for additional information.
SilverLinker Support

If your organization has set up support for the SilverLinker database, you will see a new field, called FTXT (meaning full text), in some of the displayed records.

This field contains direct links to full text articles, located at publisher web sites. If you click on the link, your default web browser launches automatically, and links to the site containing the article.

If you know that you have SilverLinker support but you do not see any records with full text links, check that you have set your options for displaying records to include the field FTXT. (See “Changing Show Options” on page 5–1.) If you still do not see any full text links, ask your MacSPIRS administrator which publisher sites you have access to: your search may not be finding any records for articles at those sites.

![Record displaying a SilverLinker link and library holdings information](image)

Displaying Local Library Holdings Information

When you look at records retrieved by a search, you may also see details of local library holdings: that is, information about whether your library

---

### 5-8 Using Retrieved Records

**SilverLinker Support**

If your organization has set up support for the SilverLinker database, you will see a new field, called FTXT (meaning full text), in some of the displayed records.

This field contains direct links to full text articles, located at publisher web sites. If you click on the link, your default web browser launches automatically, and links to the site containing the article.

If you know that you have SilverLinker support but you do not see any records with full text links, check that you have set your options for displaying records to include the field FTXT. (See “Changing Show Options” on page 5–1.) If you still do not see any full text links, ask your MacSPIRS administrator which publisher sites you have access to: your search may not be finding any records for articles at those sites.

![Record displaying a SilverLinker link and library holdings information](image)

**Displaying Local Library Holdings Information**

When you look at records retrieved by a search, you may also see details of local library holdings: that is, information about whether your library
has a copy of the publication, and if so, where it is stored. The exact
details you see depend on whether your MacSPIRS administrator has set
this feature, and the amount of detail about location and availability that
they have decided to include.

You can only see holdings information if the fields *LHM and *LHC are
supported by the database, and if you select them to display. See
“Changing Show Options” on page 5–1.

FIGURE 5-6 shows records with the field *LHM. One record shows the
library reference number for the article. The second record has a hotlink
to an electronic copy of the publication.

Selecting Records

You can select a subset of the records retrieved by your most recent
search request and then show, print, or save the subset, rather than the
entire set of retrieved records.

Using the Retrieved Records Window

1. If necessary, perform a search and click Show Records Found to
display the Retrieved Records window.
2. In the Retrieved Records window, browse the records using the
scroll bar or Next Record and Previous Record buttons.
3. Select any record of interest by clicking on its record number, such
as 2 of 492. The number appears in bold to indicate that the record is
selected.
4. Continue browsing and select all relevant records.
Using the Show Records dialog box

1. Click **Selected Records** in the Show Records dialog box. MacSPIRS displays the Selecting Records dialog box.

   ![Selecting Records dialog box](image)

   **FIGURE 5-8 The Selecting Records dialog box**

2. Enter the records you want to select. You can enter a single record number, a non-consecutive group of numbers, or a range.

3. Click **OK** to select the records.
Deselecting records

Do one of the following:

- Click again on any selected (bold) record number in the Retrieved Records dialog box.
- Click **Clear All Selected Records** in the Selecting Records dialog box.

**Note:** If you attempt to exchange databases or restart or quit MacSPIRS with one or more selected records, MacSPIRS displays the Selected Records Warning dialog box, which allows you to print, save, or discard the selected records.

![Selected Records Warning dialog box](image)

**FIGURE 5-9 Selected Records Warning dialog box**

You must discard all selected records before exchanging, restarting, or quitting.

- Click **Print selected records** or **Save selected records** to print or save the records.

  If **Then discard** is checked, MacSPIRS discards the selected records after printing or saving them, and continues with the exchange, restart, or quit.

  If **Then discard** is unchecked, MacSPIRS re-displays the Selected Records Warning after printing or saving the records.

- Click **Discard Selections** to discard the selected records and continue with the exchange, restart, or quit.

Refer to “Printing Records” on page 5–12 and “Saving Records” on page 5–15 for more information.
Printing Records

With MacSPIRS, you can print the records retrieved by the current search. You can also determine which records and fields are printed, and whether the search history is included.

To print records:

1. Select **Print Records** from the **File** menu or hold down the **Command** key [⌘] and press [P]. MacSPIRS displays the Print Records dialog box.

![Print Records dialog box](image)

**FIGURE 5-10 The Print Records dialog box**

2. If necessary, click **Select Fields** to select the fields you want to print. Refer to “Printing a Subset of Fields” on page 5–13 for instructions on selecting fields.

3. Select the records you want to print:
   - Click **Selected Records** to print only the records you have selected.
   - Click **All Records** to print all retrieved records.
   - Click **Hotlink** to print only hotlinked records. (See “Displaying Hotlinked Records” on page 5–6 for more information on hotlinks.)

4. If you want to print the contents of the Search History window along with your printed records, click the **Include Search History** box.

5. Select a separate pages option:
   - Click **No** to print without page breaks after each record.
   - Click **Yes** to print each record on a new page.

6. Use the **Start printing from record #** box to set a record number at
which you want your print run to begin. The default is the first retrieved record, or the first record of the selection.

7. Click **Print**. MacSPIRS displays a progress message. To stop printing, click the **Break** button displayed with the message.

### Printing a Subset of Fields

The fields to be printed are indicated by the message next to the **Select Fields** button in the Print Records dialog box. By default, all fields are printed. However, you can use **Select Fields** to choose the fields you want to print.

To print a subset of fields:

1. Click **Select Fields** in the Print Records dialog box. MacSPIRS displays the Select Fields dialog box which lists all fields and fieldsets available for printing.

![Select Fields Dialog Box](image)

**FIGURE 5-11 The Print Records-Select Fields dialog box**

2. If you want to see a description and search example for a field, click on its long name.

3. Click on the short name of each field you want to print. MacSPIRS places a check to the left of your selections. Note that if you select a fieldset, MacSPIRS places a check to the left of all of the fields that make up the set.

   - To print all fields, select **ALL Fields**.
   - To print most fields, select **ALL Fields** and then deselect those fields that you do not want to print.
• To print only the fields that contain one of your search terms, select **Hits**. “Hits” are occurrences of your search terms in retrieved records. Hits occur in different fields from one record to the next, so selecting **Hits** is the most efficient way of printing all occurrences of your search terms.

4. If you want to deselected a field, click again on its short name. MacSPIRS removes the check.

To clear all field selections at once, click **Clear**. However, you must make at least one field selection before clicking **OK**.

5. Click **OK** when you have selected the fields you want to print.

### Changing Print Options

The Options for Print dialog box allows you to control how the records retrieved by your most recent search are printed. You can indicate whether you want hits highlighted and how you want field labels printed.

1. Select **Options for Print** from the **File** menu. MacSPIRS displays the Options for Print dialog box.

![Options for Print dialog box](image)

*FIGURE 5-12 The Options for Print dialog box*

2. Check the **Highlight Hits** box to highlight your search terms where they appear in the retrieved records. Hits are highlighted by default.

3. Select the **Field Labels** option you want:
   - Click **Long** to print records with full field names, such as “Title.”
   - Click **Short** to print records with abbreviated field names, such as “TT” for the “Title” field. MacSPIRS prints retrieved records with short field labels by default.
   - Click **None** to print records without field names.
4. Check **Remember Field Selections** if you want MacSPIRS to remember the field settings you have selected, and print only those fields for all records you retrieve from any database. (See “Showing a Subset of Fields” on page 5–4 for instructions on selecting fields.)

If you want MacSPIRS to use your field selections for only the database you are using now, and any member of that database family, check both **Remember Field Selections** and **DB Qualify Fields**.

This information is stored with your preferences. Next time you start MacSPIRS, or exchange databases, you see a message saying that your preferences override the entry in your configuration file (your .ini file). If you only checked **Remember Field Selections** MacSPIRS prints records with the fields you have selected. If you checked both options, MacSPIRS prints records with all fields, except for the database family that was current when you checked the **DB Qualify Fields** option. For that database family, MacSPIRS prints only your selected fields.

5. Click **OK**.

---

**Saving Records**

With MacSPIRS, you can save the records retrieved by the current search. You can also determine which records and fields are saved, and whether the search history is included.

To save records:

1. Select **Save Records** from the **File** menu. MacSPIRS displays the Save Records dialog box.

   ![Save Records dialog box](image)

   *FIGURE 5-13 The Save Records dialog box*

2. If necessary, click **Select Fields** to select the fields you want to
include in the saved records. Refer to “Saving a Subset of Fields” on page 5–16 for instructions.

3. Select the records you want to save:
   - Click Selected Records to save only the records you have selected.
   - Click All Records to save all records retrieved from your most recent search.
   - Click Hotlink to save only hotlink records. For more information on hotlinks, refer to “Displaying Hotlinked Records” on page 5–6.

4. If you want to save the contents of the Search History window along with your saved records, click the Include Search History box.

5. Use the Start saving from record # box if you want to start saving with a specific record number. The default is the first retrieved record, or the first record of the selection.

6. Click Save.... MacSPIRS displays the Macintosh Save dialog box, which allows you to specify a name and destination for your saved file.

7. Type the name of the file and specify a drive and folder in which to save the retrieved records.

8. Click Save. MacSPIRS displays a progress message. To stop saving, click the Break button displayed with the progress message.

Saving a Subset of Fields

The fields to be saved are indicated by the message next to the Select Fields button in the Save Records dialog box. By default, all fields are saved. However, you can use Select Fields to choose the fields you want to save.

To save a subset of fields:

1. Click Select Fields. MacSPIRS displays the Select Fields dialog
box which lists all fields and fieldsets available for saving.

![Save Records-Select Fields dialog box](image)

**FIGURE 5-14 The Save Records-Select Fields dialog box**

2. To see a description and search example for a field, click on its long name.

3. Click on the short name of each field you want to save. MacSPIRS places a check to the left of your selections. Note that if you select a fieldset, MacSPIRS places a check to the left of all of the fields that make up the set.
   - To save all fields, select **ALL Fields**.
   - To save most fields, select **ALL Fields** and then deselect those fields that you do not want to save.
   - To save only the fields that contain one of your search terms, select **Hits**. "Hits" are occurrences of your search terms in retrieved records. Since hits occur in different fields from one record to the next, selecting **Hits** is the most efficient way of saving all occurrences of your search terms.

4. If you want to deselect a field, click again on its short name. MacSPIRS removes the check.
   
   To clear all field selections at once, click **Clear**. However, you must make at least one field selection before clicking **OK**; you cannot save records if no fields have been selected.

5. Click **OK** when you have selected the fields you want to save.
Changing Save Options

The Options for Save dialog box allows you to control how the records retrieved by your most recent search are saved. You can indicate how you want field names saved and, if a file with the name you intend to use exists, whether you want to replace it or append to it.

1. Select Options for Save from the File menu. MacSPIRS displays the Options for Save dialog box.

![Options for Save dialog box]

**FIGURE 5-15 The Options for Save dialog box**

2. Select the Field Labels option you want:
   - Click Long to save records with full field names, such as “Title.”
   - Click Short to save records with abbreviated field names, such as “TI” for the “Title” field. MacSPIRS saves retrieved records with short field labels by default.
   - Click None to save records without field names.

3. Select the If file exists option you want:
   - Click Replace to overwrite the contents of an existing file with the same name. This means that you will no longer be able to access the data originally held in that file. As an alternative, you can either append the saved records to the existing file, or specify another (unused) file name.
   - Click Append to add the saved records to the contents of an existing file. MacSPIRS appends saved records to the specified file by default.

4. Check Remember Field Selections if you want MacSPIRS to remember the field settings you have selected, and save only those fields for all records you retrieve from any database. (See “Showing a Subset of Fields” on page 5–4 for instructions on selecting fields.)
If you want MacSPIRS to use your field selections for only the database you are using now, and any member of that database family, check both **Remember Field Selections** and **DB Qualify Fields**.

This information is stored with your preferences. Next time you start MacSPIRS, or exchange databases, you see a message saying that your preferences override the entry in your configuration file (your .ini file). If you only checked **Remember Field Selections** MacSPIRS saves records with the fields you have selected. If you checked both options, MacSPIRS saves records with all fields, except for the database family that was current when you checked the **DB Qualify Fields** option. For that database family, MacSPIRS saves only your selected fields.

5. Click **OK**.
5-20 Using Retrieved Records
## MacSPIRS Commands

This chapter briefly describes all of the MacSPIRS menu commands. For more information, refer to the Index or the online Help.

<table>
<thead>
<tr>
<th>Menu Option</th>
<th>Menu</th>
<th>Does this</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Browse Index</strong></td>
<td>Search</td>
<td>Lets you look up a term in any available index in the current database and to browse for related terms, more specific terms, and spelling variations. You can then select and search for terms knowing exactly how many records you will retrieve.</td>
</tr>
<tr>
<td><strong>Browse Thesaurus</strong></td>
<td>Thesaurus</td>
<td>If the database you are searching includes a thesaurus, this lets you look up, get details about, and search for, thesaurus terms.</td>
</tr>
<tr>
<td><strong>Clear</strong></td>
<td>Edit</td>
<td>Erases selected text from the Find Records, Browse Index, or Browse Thesaurus dialog box.</td>
</tr>
<tr>
<td><strong>Clear Searches</strong></td>
<td>Search</td>
<td>Lets you remove search requests from the Search History window.</td>
</tr>
<tr>
<td><strong>Copy</strong></td>
<td>Edit</td>
<td>Copies the highlighted text to the Clipboard for later pasting.</td>
</tr>
<tr>
<td><strong>Cut</strong></td>
<td>Edit</td>
<td>Removes selected text and places a copy of it in the Clipboard.</td>
</tr>
<tr>
<td><strong>Exchange Databases</strong></td>
<td>File</td>
<td>Lets you switch databases without leaving MacSPIRS.</td>
</tr>
<tr>
<td><strong>Find Records</strong></td>
<td>Search</td>
<td>Lets you create a new search request or to view a list of your previous searches (the search history.)</td>
</tr>
<tr>
<td><strong>Font</strong></td>
<td>Show</td>
<td>Lets you select the font you want to use for displaying and printing retrieved records.</td>
</tr>
</tbody>
</table>

*Note:* This command is unavailable if the **Allow users to exchange databases** option is disabled during MacSPIRS installation.
<table>
<thead>
<tr>
<th>Menu Option</th>
<th>Menu</th>
<th>Does this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Guide to...</td>
<td>Help</td>
<td>Provides specific help on all currently loaded databases, and includes</td>
</tr>
<tr>
<td></td>
<td></td>
<td>the following commands:</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Guide Topics</strong> provides a list of Help topics for the selected data-</td>
</tr>
<tr>
<td></td>
<td></td>
<td>base. Common topics include an Introduction, Examples, and Stopwords.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Guide Fields</strong> lists the fields contained in the selected database.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>You can get a description and search example for any field by clicking on</td>
</tr>
<tr>
<td></td>
<td></td>
<td>it.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Guide Keywords</strong> is an index of all the key words and phrases used in</td>
</tr>
<tr>
<td></td>
<td></td>
<td>the Guide Topics.</td>
</tr>
<tr>
<td>Help on SilverPlatter</td>
<td>Help</td>
<td>Provides instructions on using the <strong>Help</strong> menu and context-sensitive</td>
</tr>
<tr>
<td>Help</td>
<td></td>
<td>help.</td>
</tr>
<tr>
<td>Hide Clipboard</td>
<td>Edit</td>
<td>Closes the Macintosh Clipboard (the facility that holds the last item of</td>
</tr>
<tr>
<td></td>
<td></td>
<td>information that you stored using <strong>Cut</strong> or <strong>Copy</strong>.) Once you close</td>
</tr>
<tr>
<td></td>
<td></td>
<td>the Clipboard, the command name changes to <strong>Show Clipboard</strong>.</td>
</tr>
<tr>
<td>Hide Intermediate</td>
<td>Search</td>
<td>Prevents MacSPIRS from displaying search results for each word in your</td>
</tr>
<tr>
<td>Results</td>
<td></td>
<td>search phrase in the Search History window.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>When you select <strong>Hide Intermediate Results</strong>, the menu item changes to</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Show Intermediate Results</strong>.</td>
</tr>
<tr>
<td>Lateral Search</td>
<td>Search</td>
<td>If a retrieved record contains a word or phrase that you would like to</td>
</tr>
<tr>
<td></td>
<td></td>
<td>add to your search, use this command to add the term automatically to the</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Find Records dialog box.</td>
</tr>
<tr>
<td>List Databases and</td>
<td>Help</td>
<td>Displays a list of all databases and fields currently in use.</td>
</tr>
<tr>
<td>Fields</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MacSPIRS Help</td>
<td>Help</td>
<td>Provides help on using the MacSPIRS software. It includes the following</td>
</tr>
<tr>
<td></td>
<td></td>
<td>commands:</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>MacSPIRS Help Topics</strong> offers general advice on using MacSPIRS. Topics</td>
</tr>
<tr>
<td></td>
<td></td>
<td>include searching, using the Index and Thesaurus, and printing, saving,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>and showing records.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>MacSPIRS Help Keywords</strong> is an index of all the key words and phrases</td>
</tr>
<tr>
<td></td>
<td></td>
<td>used in the MacSPIRS Help Topics.</td>
</tr>
<tr>
<td>Next Hit</td>
<td>Show</td>
<td>Moves to the next occurrence of your search term within the retrieved</td>
</tr>
<tr>
<td></td>
<td></td>
<td>records.</td>
</tr>
<tr>
<td>Next Record</td>
<td>Show</td>
<td>Moves to the record immediately following the current record.</td>
</tr>
<tr>
<td>Menu Option</td>
<td>Menu</td>
<td>Does this</td>
</tr>
<tr>
<td>------------------</td>
<td>--------</td>
<td>---------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Options for Print</td>
<td>File</td>
<td>Lets you control how the records retrieved by your most recent search are printed. You can indicate whether you want hits highlighted, how you want field names printed, and which fields you want to print.</td>
</tr>
<tr>
<td>Options for Save</td>
<td>File</td>
<td>Lets you control how the records retrieved by your most recent search are saved. You can indicate how you want field names saved, which fields you want to save, and, if a file with the name you intend to use exists, whether you want to replace it or append to it.</td>
</tr>
<tr>
<td>Options for Show</td>
<td>Show</td>
<td>Lets you select fields and field labels (and save those settings), and control the immediate record display feature.</td>
</tr>
<tr>
<td>Page Setup</td>
<td>File</td>
<td>Lets you change the format, orientation, etc., of the page on which your retrieved records will be printed. See your Macintosh documentation for more information on Page Setup options.</td>
</tr>
<tr>
<td>Paste</td>
<td>Edit</td>
<td>Inserts the contents of the Clipboard at the current insertion point. You can paste text into the Find Records, Browse Index, or Browse Thesaurus text entry box, or into another application.</td>
</tr>
<tr>
<td>Preferences</td>
<td>Edit</td>
<td>Lets you set certain interface preferences, including the color of various display elements, font and font size, and window positions.</td>
</tr>
<tr>
<td>Previous Hit</td>
<td>Show</td>
<td>Moves to the previous occurrences of your search term within the retrieved records.</td>
</tr>
<tr>
<td>Previous Record</td>
<td>Show</td>
<td>Moves to the record immediately preceding the current record.</td>
</tr>
<tr>
<td>Previous Topic</td>
<td>Help</td>
<td>Returns to the Help topic from which you linked.</td>
</tr>
<tr>
<td>Print Records</td>
<td>File</td>
<td>Prints the records retrieved by your most recent search request.</td>
</tr>
<tr>
<td>Quit</td>
<td>File</td>
<td>Clears the Search History window, resets all options and window sizes to their defaults, and returns to the Macintosh Desktop.</td>
</tr>
<tr>
<td>Restart Session</td>
<td>File</td>
<td>Clears the Search History window, resets all options and window sizes to their defaults, and returns to the database selection screen.</td>
</tr>
<tr>
<td>Run Search History</td>
<td>File</td>
<td>Runs the search requests you saved during past work sessions.</td>
</tr>
<tr>
<td>Save Records</td>
<td>File</td>
<td>Use to transfer the records retrieved by your most recent search to a disk or hard disk.</td>
</tr>
<tr>
<td>Menu Option</td>
<td>Menu</td>
<td>Does this</td>
</tr>
<tr>
<td>---------------------</td>
<td>------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Save Search History</td>
<td>File</td>
<td>Use to save any search requests you want to run during future work sessions.</td>
</tr>
<tr>
<td>SDIs <strong>(if enabled)</strong></td>
<td>File</td>
<td><strong>Save as SDI</strong> lets you set up an SDI. After conducting a search and choosing this menu item, MacSPIRS 4 links automatically to WebSPIRS and displays the Create SDI screen. <strong>Show SDI Account</strong> lets you edit or administer existing SDIs by linking to WebSPIRS to view an account you set up previously <strong>Alerts</strong> lets you view and subscribe to alerts (searches set up by a librarian or administrator) by linking to WebSPIRS. <strong>SDI Set up</strong> lets you view and edit your SDI settings.</td>
</tr>
<tr>
<td>Select Index</td>
<td>Search</td>
<td>Use to change to the index of another field or set of fields.</td>
</tr>
<tr>
<td>Show All Records</td>
<td>Show</td>
<td>Displays the records retrieved by your most recent search.</td>
</tr>
<tr>
<td>Show Clipboard</td>
<td>Edit</td>
<td>Opens the Macintosh Clipboard (the facility that holds the last item of information that you stored using the Cut or Copy command.) When the Clipboard is open, the command name changes to Hide Clipboard.</td>
</tr>
<tr>
<td>Show Intermediate Results</td>
<td>Search</td>
<td>Displays search results for each word in your search phrase in the Search History window. When you select Show Intermediate Results, the menu item changes to Hide Intermediate Results.</td>
</tr>
<tr>
<td>Show Selected Records</td>
<td>Show</td>
<td>Displays the records you select from the Retrieved Records window or through the Selecting Records dialog box.</td>
</tr>
<tr>
<td>Show Selected Term</td>
<td>Thesaurus</td>
<td>Displays the Selected Term Details window, which indicates broader, narrower, and related terms for the selected thesaurus term, and the Selected Term dialog box, which allows you to search for the selected term. If the database does not include a thesaurus or you have not selected a thesaurus term, Show Selected Term is not available.</td>
</tr>
<tr>
<td>Show Selected Tree</td>
<td>Thesaurus</td>
<td>If the database you are searching includes a thesaurus with a hierarchical, or “tree,” structure, Show Selected Tree displays the most recently selected tree in the Trees—Hierarchical Display of Terms window. If the database does not have a thesaurus or you have not selected a thesaurus tree, Show Selected Tree is not available.</td>
</tr>
<tr>
<td>Menu Option</td>
<td>Menu</td>
<td>Does this</td>
</tr>
<tr>
<td>----------------</td>
<td>--------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Sort Records</td>
<td>Show</td>
<td>Lets you sort retrieved records by a specific field. You can sort the records in ascending (1-100, A-Z) or descending (100-1, Z-A) order.</td>
</tr>
</tbody>
</table>
Index

A
ADJ operator 4-7
Alerts
  configuring 2-18
  subscribing to 4-28
All Records option
  for printing 5-12
  for saving 5-16
AND operator 4-6, 4-29
anti-virus programs 2-2
Append option, for saving 5-18
AppleTalk network 2-12
application types
  Both (Client & standalone) 2-6
  ERL Client Only 2-6
  Standalone Only 2-6
authors. see hyphenated phrases; searching in specific fields
automatic login to ERL 2-9
Automatic Restart option 2-9
Automatic Subject Lookup. see suggested terms
automatic subject lookup. see suggested terms

B
Boolean operators. see operators
Both (Client & standalone) applications 2-6
Break button
  for printing 5-13
  for saving 5-16
  for searching 4-6
broader terms. see Thesaurus
Browse Index 4-13, 6-1
  see also Index
Browse Thesaurus 4-15, 6-1
  see also Thesaurus

C
cancelling. see Break button
Change Index 4-14, 6-4
  see also Index
changing
  colours 2-16
  databases 2-8, 3-4, 4-29, 6-1
  font size 2-16
  fonts 2-16, 6-1
  indexes 4-14, 6-4
  options
    for printing 5-14, 6-3
    for saving 5-18
    for showing 5-1, 6-3
  see also options
Clear Searches 4-23, 6-1
clearing text 6-1
Clipboard
  hiding 6-2
  showing 6-4
combining search terms 4-4, 4-6, 4-8
configuring MacSPIRS
  default fields 2-13
  file names 2-14
  Immediate Record Display 2-12
  memory requirements 2-14
  subdirectory access 2-13
contents. see Table of Contents
context sensitive Help 3-10
contracting topics
  see also Table of Contents
conventions. see Manual conventions
copying text 6-1
current awareness searches
  configuring SDIs and Alerts 2-17
  using SDIs and Alerts 4-26
Current Search option, for showing 5-3
cutting text 6-1
D

Databases
- Database-specific help 3-10–3-13, 6-2
- Exchanging 2-8, 3-4, 4-29, 6-1
- Full-text. See Table of Contents
- Listing 3-11, 3-12, 6-2
- Selecting 3-2
- Selection screen 3-3
- Title screen 3-2, 3-3
- See also searching

Dedicated workstation, creating 2-15
Deleting
- See also clearing

Descriptive terms. See hyphenated phrases; Thesaurus
Displaying. See showing
Displaying. See showing
Downloading MacSPIRS 2-2

E

Eject button 3-4
Electronic Reference Library (ERL)
- ercInt.cfg file 2-7
- Installing ERL clients 2-3–2-10
- Login information
  - Concealing 2-10
  - Passwords 2-9
  - Server IDs 2-9
  - Usernames 2-9
  - Server addresses 2-7
- ERL. See Electronic Reference Library (ERL)
- Examples of searching 4-3
- Exchanging databases 3-4, 4-29, 6-1
- Installation option 2-8
- Exiting MacSPIRS 3-13
- Expanding topics
  - See also Table of Contents
- Explode Term 4-15
- Extracting MacSPIRS files 2-3

F

Fields
- Field-specific indexes. See Index
- Limit fields 4-11, 4-29
- Listing 3-11, 3-12, 6-2
- Names (labels)
  - In search requests 4-11
- Printing 5-13
- Saving 5-16
- Searching in 3-12, 4-4, 4-9
- Showing 5-4, 5-14, 5-17
- With hits 5-4, 5-14, 5-17
- File server 2-11
- Finding records 3-3, 3-6, 4-2, 6-1
- See also searching
- Finding records. See searching
- FTPing SilverPlatter software 2-2
- Full text. See Table of Contents

G

Guide to database 3-11, 6-2

H

Help
- Database-specific guide 3-10–3-13, 6-2
- MacSPIRS Help 3-10–3-13, 6-2
- History. See search history; Thesaurus history
- Hits, showing 5-4, 5-14, 5-17
- Hotlinks
  - Definition of 5-6
  - Printing 5-7, 5-12
  - Saving 5-7, 5-16
  - Showing 5-6
- Hyphenated phrases 4-4

I

Immediate Record Display 2-12, 5-3
IN operator 4-4, 4-9, 4-10
Include Search History
Index

Authors in 4-5
Broadening searches with 4-30
Changing 4-14, 6-4
Descriptive phrases in 4-5
Narrowing searches with 4-30
Overview 3-8
Searching 4-12
Selecting terms from 4-13
Installing MacSPIRS 2-1–2-12
Application types 2-6
Code types 2-6
Installation types 2-4
Network instructions 2-11
Software options 2-8–2-9
Interface preferences
Colours 2-16
defaults 2-16
Font 2-16, 6-1
Font Size 2-16
Preferences command 6-3
Save window settings 2-16
Intermediate search results
Hiding 6-2
Showing 4-2, 6-4

L
lateral searching 5-6
Library holdings
displaying details 5-8
Limit fields 4-10, 4-11, 4-29
List Databases and Fields 3-11, 3-12, 6-2
List of Available Indexes 4-13, 4-14
List of Permutated Terms 4-16

M
MacSPIRS
Configuring 2-12–2-15
Help 3-10–3-13, 6-2
Installing 2-1–2-12
Interface preferences 6-3
License Agreement 2-5
Overrides folder 2-11
Quitting 3-13, 6-3
Restarting 3-13, 6-3
Starting 3-1
Manual conventions vii
Memory requirements 2-14
Menu Help 3-10, 6-2

N
narrower terms. See Thesaurus
Narrowing search requests 4-29
Natural language mapping. See suggested terms
NEAR operator 4-6, 4-29
Next Record 5-6, 5-9, 6-2
NOT operator 4-8, 4-29
Novell server 2-11

O
operators
ADJ 4-7
AND 4-6, 4-29
definitions of 4-6
IN 4-4, 4-9, 4-10
in limit fields 4-11
NEAR 4-6, 4-29
NOT 4-8, 4-29
OR 4-7, 4-14, 4-30, 5-6
WITH 4-6, 4-29
Options for Print 5-14, 6-3
Options for Save 5-18
Options for Show 5-1, 5-2, 6-3
Options. See installing MacSPIRS; printing; saving; showing
OR operator 4-7, 4-14, 4-30, 5-6

P
Page Setup, print option 6-3
parentheses 4-4
parentheses in search requests 4-5
passwords, ERL 2-9
pasting text 6-3
Permuted Terms 4-16
Preconfigure Defaults 2-4
Preferences. see interface preferences preferences. see options
preferred terms 4-15
Previous Hit 6-3
Previous Record 5-6, 5-9, 6-3
Previous Topic 6-3
printing
Break button 5-13
fields, selected 5-13
hotlink records 5-7
options 5-14
Page Setup 6-3
Printable Records option 2-8
records 5-12–5-15
search histories 4-22, 5-12
proximity operators. see operators
Q
quitting MacSPIRS 3-13, 6-3
quotes 4-4
R
range searching 4-11
Reconfigure Installed Application 2-4
records
deselecting 5-11
printing 5-12–5-15
saving 5-15–5-19, 6-3
scrolling 5-6
selecting
for printing 5-9–5-10
for saving 5-9–5-10
for showing 5-9–5-10
terms from 5-6
showing 5-1–5-5, 6-4
sorting 5-5, 6-5
see also downloading; printing;
searching; showing
related terms 4-15
related terms. see Thesaurus
Replace option, for saving 5-18
restarting MacSPIRS 3-13, 6-3
installation option 2-9
reusing search requests 3-4, 4-4, 4-22
Run Search History 4-24, 4-25, 6-3
S
Save Records 5-15, 6-3
Save Search History 4-23, 6-4
saving
Break button 5-16
fields, selected 5-16, 5-17
options 5-18
records 5-15–5-19, 6-3
search histories 4-23, 5-16, 6-4
window settings 2-16
see also downloading
scrolling records 5-6
SDIs
configuring 2-18
creating 4-27
software option 2-9
Search History
after exchanging databases 3-4
clearing searches from 4-23, 6-1
complex search requests in 4-5
printing 4-22, 5-12
reusing searches from 4-22
running 4-24, 6-3
saving 4-23, 5-16, 6-4
search requests
clearing from Search History 4-23, 6-1
combining terms in 4-6, 4-8
creating 3-6, 4-2
hyphens in 4-4
narrowing 4-29
operators in 4-6, 4-8
parentheses in 4-5
reusing 3-4, 4-22
selecting terms for
  from retrieved records 5-6
  from the Index 4-12, 4-30
  from the Thesaurus 4-15–4-16, 4-30
truncation in 4-4, 4-30
wildcards in 4-4, 4-30
searching
  after exchanging databases 3-4
  Break button 4-6
  examples 3-6, 4-2–??, 4-3
  fields 4-4
  finding word variants 4-3
  for suggested terms 4-11
  hyphenated phrases 4-4
  in a specific field 3-11, 4-9
  in limit fields 4-10
  in the Index 4-12
  in the Thesaurus 4-15–4-16, 4-18–4-20
multiple databases 4-29
numbers 4-3
operators 4-4
overview 3-6
parentheses 4-4
quotes 4-4
reusing previous searches 4-4
semi-colons 4-4
truncation and wildcards 4-3
see also Index; search history; Table of Contents; Thesaurus
Selected Fields
  for printing 5-12, 5-13
  for saving 5-15, 5-16, 5-17
  for showing 5-2, 5-4
Select Index 4-14, 6-4
Selected Records
  option
records 5-1–5-5
overview 3-6
Show Records Found button 4-2, 5-9
subsets
of fields 5-4
of records 5-3
see also viewing
SilverLinker
configuring 2-17
displaying links 5-8
SilverPlatter Information 1-3
Simultaneous Users option 2-9
Skip to Record option
for showing 5-3
software
options
Automatic Restart 2-9
Printable records 2-8
SDIs 2-9
Simultaneous Users 2-9
Timeout (minutes) 2-9
Update Magnetic Files 2-9
sorting records 6-5
SPLHA. see library holdings
Standalone Only applications 2-6
starting MacSPIRS 3-1
Startup screen 2-15
stopwords 4-12
subheadings 4-15, 4-20
suggested terms 4-11
Switch CFG file option 2-7
synonyms 4-15
synonyms. see Thesaurus
T
tables. see Fixed Font
Term Details 4-16
Thesaurus
  broadening searches with 4-30
  Explode Term 4-15
  List of Permutated Terms 4-16
  narrowing searches with 4-30
overview 3-9
Permutated Terms 4-16
Search List button 4-20
searching 4-15–4-16, 4-18–4-20
selected terms
deleting 4-20
getting details about 4-16
searching 4-20
viewing 4-19
Show Selected Tree 6-4
subheadings 4-15, 4-20
suggested terms 4-11
trees, displaying 4-17
Timeout (minutes) option 2-9
title screen 3-2, 3-3
trees, displaying 4-17
truncation 4-3, 4-4, 4-30
U
Update Magnetic Files option 2-9
User License Agreement 2-5
usernames, ERL 2-9
V
valid search requests 4-3
viewing
tables. see Fixed Font
  see also showing
viewing. see showing
W
wildcards 4-4, 4-30
window settings, saving 2-16
WITH operator 4-6, 4-29